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Getting Started: WP-8147/8447/8847 

The WinPAC-8xx7/WP-8x47 is the abbreviation of the WP-8147/8447/8847. 

 

Important Notice   

1. WP-8x47/8xx6 supports only High profile I-8K and I-87K I/O cards in its slot 0 to 7. Visit the website: 
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support
__+I-8K_I-87K__Software__Support 

1. Only set a fixed IP address to the WP-8x47. (No DHCP) 

2. Only set WP-8x47’s LAN2 as disabled if not using it (refer to Appendix D). 

3. Recommend to use the Industrial Ethernet Switch (e.g., NS-205/208 or RS-405/408) for PAC. 

4. Please store your application programs and data files in the \Micro_SD. Don't store them in the 

\System_disk. That is because the \System_Disk is using NOR Flash memory. Its size is small and the 

major purpose is for storing OS, ISaGRAF driver, some basic utilities and DLL. The NOR Flash memory 

is not good for frequently updating files. If update files frequently in the \System_Disk (for example, 

update a file every 1 to 5 seconds, then it will be about ten thousand more updates in one day), the 

data or files in the \System_disk may crush or lost for some days or months later. 

 

Legal Liability 

ICP DAS assumes no liability for any damage resulting from the use of this product. ICP DAS reserves the 

right to change this manual at any time without notice.  

 

The information furnished by ICP DAS is believed to be accurate and reliable. However, no responsibility 

is assumed by ICP DAS for its use, not for any infringements of patents or other rights of third parties 

resulting from its use. 

 
 

Trademark & Copyright Notice 

The names of products and name of company are used for identification purposes only, and are the 

registered trademarks of their respective owners or companies. 

 
 

Development Software 

Two options: 

1) ISaGRAF: Ver. 3.4x (or Ver. 3.5x), IEC 61131-3 standard. LD, ST, FBD, SFC, IL & FC  

2) Non-ISaGRAF: Microsoft EVC++4.0 or VS.NET 2008/2005/2003 (VB.net, C#.net)  

 

- ISaGRAF Website: 

https://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF 

- ISaGRAF Download Center 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf 
 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
https://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF
https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf
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Technical Service 

Please contact local agent or email problem-report to  service@icpdas.com . 

Visit the www.icpdas.com for more information about products. 

ISaGRAF FAQ : https://www.icpdas.com/en/faq/index.php?kind=280#751 

 
 

Written by Chun Tsai;       Edited by Janice Hong / Eva Li.  

Copyright Jan. 2009, by ICP DAS CO., LTD. All Rights Reserved.      

 

 

Revision History 

The table below shows the revision history. 
 

Revision Date Editor Description 

V2.0 Oct. 2020 Janice 

 Update the new URLs, some pictures 

 Remove some FTP URLs and the path of CD 

 Adjust layout and font and reword some sentence 

 Appendix I.3 Change the serial touch driver 

 

 

mailto:service@icpdas.com
http://www.icpdas.com/home.htm
https://www.icpdas.com/en/faq/index.php?kind=280#751


 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         3 

Table of Contents 

Getting Started: WP-8147/8447/8847 ................................................................................................. 1 

Important Notice .................................................................................................................................. 1 

Legal Liability ........................................................................................................................................ 1 

Trademark & Copyright Notice ............................................................................................................ 1 

Development Software ........................................................................................................................ 1 

Technical Service .................................................................................................................................. 2 

Revision History .................................................................................................................................... 2 

Table of Contents ............................................................................................................................... 3 

Reference Guide ................................................................................................................................. 7 

I/O Modules Selection Guide .............................................................................................................. 8 

Specifications: WP-8147/8447/8847 ................................................................................................... 9 

Chapter 1 Typical Application....................................................................................................... 1-1 

1.1 Redundant Communication System........................................................................................... 1-1 

1.2 Redundant System - Ethernet I/O .............................................................................................. 1-2 

1.3 Redundant System - RS-485 I/O ................................................................................................. 1-3 

1.4 Modbus Master: RTU, ASCII, RS-232/485/422........................................................................... 1-4 

1.5 Modbus Master: TCP/IP ............................................................................................................. 1-4 

1.6 Modbus Slave: RTU/TCP ............................................................................................................. 1-5 

1.7 Communicate with Other TCP/IP Server or UDP Client/Server Devices .................................... 1-5 

1.8 Multiple Web HMI – Monitor & Control Everywhere! .............................................................. 1-6 

1.9 Send Email with One Attached File ............................................................................................ 1-6 

1.10 Data-Recorder & Data-Logger .................................................................................................... 1-7 

1.11 Remote I/O Application .............................................................................................................. 1-7 

1.12 SMS: Short Message Service ...................................................................................................... 1-8 

1.13 As a Modbus Gateway for the Remote I/O Modules ................................................................. 1-8 

1.14 Motion Control ........................................................................................................................... 1-9 

1.15 Stress Monitoring Application of Constructions ........................................................................ 1-9 

1.16 Fast FRnet Remote I/O .............................................................................................................1-10 

1.17 Integrate with CAN/CANopen Devices & Sensors ...................................................................1-10 

1.18 VIP Communication Security ....................................................................................................1-11 

1.19 ISaGRAF PAC Connects the Smart Power Meter ......................................................................1-11 

1.20 ZigBee Wireless Solution ..........................................................................................................1-12 

1.21 GPS Application: ISaGRAF PAC Plus I-87211W & GPS-721 ......................................................1-13 

1.22 Data Exchange: Ebus ................................................................................................................1-14 

1.23 Detect Hot-Swap I-87K (High Profile) I/O Status ......................................................................1-14 

1.24 Database Application ...............................................................................................................1-15 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         4 

1.25 HART Solutions .........................................................................................................................1-16 

1.26 3G/4G Wireless Application .....................................................................................................1-17 

1.27 Measure Humidity and Temperature Values via DL-100TM485 .............................................1-17 

Chapter 2 Software Installation.................................................................................................... 2-1 

2.1 Step 1 - Installing the ISaGRAF Software ................................................................................... 2-1 

2.1.1 The Hardware Protection Device (Dongle & USB Key-Pro)................................................. 2-2 

2.1.2 Important Notice for Window 2000 Users .......................................................................... 2-3 

2.1.3 Important Notice for Window NT Users ............................................................................. 2-3 

2.1.4 Important Notice for Windows Vista or Windows 7 (32-bit) Users .................................... 2-4 

2.1.5 Important Notice for Windows (64-bit) Users .................................................................... 2-6 

2.1.6 Important Setting for Using Variable Arrays ....................................................................... 2-6 

Step 2 - Installing the ICP DAS Utilities for ISaGRAF ............................................................................. 2-7 

Chapter 3 Setting Up a Web HMI Demo ....................................................................................... 3-1 

3.1 Web Demo List ........................................................................................................................... 3-1 

3.2 Steps to Set Up a Web HMI Demo ............................................................................................. 3-2 

3.2.1 Step 1 - Setup the Hardware ............................................................................................... 3-2 

3.2.2 Step 2 - Setting the Web Options........................................................................................ 3-2 

3.2.3 Step 3 - Download ISaGRAF Project .................................................................................... 3-3 

3.2.4 Step 4 - Download Web Pages to the WinPAC ................................................................... 3-6 

3.2.5 Step 5 - Show Time .............................................................................................................. 3-6 

Chapter 4 Programming A Web HMI Example .............................................................................. 4-1 

4.1 Writing a Simple ISaGRAF Program ............................................................................................ 4-2 

4.1.1 Open ISaGRAF - Project Management ................................................................................ 4-3 

4.1.2 Creating an ISaGRAF User’s Group ...................................................................................... 4-3 

4.1.3 Creating a New ISaGRAF Project ......................................................................................... 4-4 

4.1.4 Declaring the ISaGRAF Project Variables ............................................................................ 4-5 

4.1.5 Assign Modbus Network Address No. to Variables ............................................................ 4-8 

4.1.6 Create the LD Program - "LD1" .........................................................................................4-10 

4.1.7 Edit the "LD1" Program .....................................................................................................4-11 

4.1.8 Connecting the I/O ............................................................................................................4-14 

4.2 Compiling & Simulating the Example Project ..........................................................................4-17 

4.3 Download & Debug the Example Project .................................................................................4-21 

4.4 Design the Web Page ...............................................................................................................4-27 

4.4.1 Step 1 – Copy the Sample Web HMI Pages .......................................................................4-27 

4.4.2 Step 2 – Building the Main.htm ........................................................................................4-28 

4.4.3 Step 3 – Adding Control Code to the Main.htm................................................................4-33 

4.4.4 Step 4 – Download Web HMI Pages to the PAC ...............................................................4-40 

Chapter 5 Web HMI Basics ........................................................................................................... 5-1 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         5 

5.1 Basic Files for the Web HMI ....................................................................................................... 5-1 

5.2 Login.htm ................................................................................................................................... 5-2 

5.3 Menu.htm................................................................................................................................... 5-4 

5.4 Main.htm .................................................................................................................................... 5-6 

5.4.1 A Simple Main.htm Example ............................................................................................... 5-6 

5.4.2 More About the refresh_data( ) Function and Dynamic Data ............................................ 5-8 

5.4.3 Post Data to the PAC .........................................................................................................5-13 

5.5 Multi-Pages ..............................................................................................................................5-17 

5.5.1 Level 2 and Level 3 Page ...................................................................................................5-17 

5.5.2 Switch One Page to One Another Page .............................................................................5-18 

5.6 Web Security ............................................................................................................................5-19 

Chapter 6 Using VB.net 2008 Program to Access ISaGRAF Variables ............................................. 6-1 

6.1 Create a New Project ................................................................................................................. 6-1 

6.2 Add Project Reference for an Application.................................................................................. 6-3 

6.3 Compiling an Application Program ............................................................................................ 6-5 

6.4 QuickerNET.DLL .......................................................................................................................... 6-6 

6.4.1 Digital R/W Functions .......................................................................................................... 6-6 

6.4.2 Analog R/W Functions ......................................................................................................... 6-8 

Chapter 7 Using EVC++ Program to Access ISaGRAF Variables ....................................................... 7-1 

Chapter 8 Using InduSoft Project to Access ISaGRAF Variables ..................................................... 8-1 

Chapter 9 Demo Program & FAQ .................................................................................................. 9-1 

9.1 Get On-Line Help ........................................................................................................................ 9-1 

9.2 Installing the ISaGRAF Programming Examples ......................................................................... 9-4 

9.3 Frequently Asked Questions ....................................................................................................9-11 

Chapter 10 Using C# .net 2008 Program to Access ISaGRAF Variables ........................................... 10-1 

10.1 Create a New Project ...............................................................................................................10-1 

10.2 Add Project Reference for an Application................................................................................10-3 

10.3 Compiling an Application Program ..........................................................................................10-5 

10.4 QuickerNET.DLL ........................................................................................................................10-6 

10.4.1 Digital R/W Functions ........................................................................................................10-6 

10.4.2 Analog R/W Functions .......................................................................................................10-8 

Chapter 11 More Useful Features ................................................................................................ 11-1 

11.1 FAQ-167: Develop your Own C-function and C-function Blocks in the ISaGRAF WinCE PAC ..11-1 

11.2 FAQ-166: ISaGRAF WinCE PAC - Schedule Control ..................................................................11-2 

Appendix A Hardware System & Setting ............................................................................................ 1 

A.1 Applying Correct Power Supply ..................................................................................................... 1 

A.2 Modify the NET-ID & Modbus RTU Port Setting ........................................................................... 2 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         6 

A.3 Setting the IP Address for the WP-8x47 ........................................................................................ 3 

A.4 Connecting the PC to the WP-8x47 Ethernet Port ........................................................................ 4 

A.5 Multi-Clients Connections and Pin Assignment of COM1, COM2, COM3 and COM4 .................. 5 

A.6 Connecting PC to the COM Port of the WP-8x47 .......................................................................... 7 

A.7 Deleting the ISaGRAF Project from the WP-8x47 ......................................................................... 8 

A.8 Linking I-7000 and I-87K Modules for Remote I/O ....................................................................... 9 

A.9 Linking to an HMI Interface Device ............................................................................................. 10 

A.10 Linking to Other Modbus Devices ............................................................................................... 11 

A.11 Control the LED Indicator ............................................................................................................ 12 

Appendix B Upgrade ISaGRAF WinPAC Driver .................................................................................. 13 

Appendix C Dimension .................................................................................................................... 17 

Appendix D How to Enable/Disable WP-8x47’s LAN2 ....................................................................... 20 

Appendix E Using RS-232/485/422 Expansion Modules ..................................................................... 21 

Appendix F Slow Down ISaGRAF Driver’s Speed............................................................................... 24 

Appendix G Setup More Modbus RTU Salve Ports ............................................................................ 25 

Appendix H Compiling Error Result in Different ISaGRAF Version ..................................................... 26 

Appendix I Using RS-232 Serial/USB Touch Monitor ........................................................................ 27 

I.1 Touch Monitor Drivers and Notice for installing ........................................................................ 27 

I.2 Using the USB Touch Monitor ..................................................................................................... 28 

I.3 Using the RS-232 Serial Touch Monitor ...................................................................................... 29 

I.4 Uninstalling the Touch Monitor Driver ....................................................................................... 30 

I.5 Adjust the WinPAC Display Frequency ........................................................................................ 31 

Appendix J  Why my PC Running ISaGRAF cannot Connect the ISaGRAF PAC Correctly? ................... 32 

Appendix K Enable the Screen Saver of WinPAC ............................................................................... 33 

Appendix L How to Detect the Status of Dual Battery and the Ethernet Port .................................... 34 

 

 

 

 

 

 

 

 

 

 

 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         7 

Reference Guide 

ISaGRAF Resource on the Internet: 

Newly released ISaGRAF IO libraries, PAC drivers, demo, and manuals can be found on: 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf 

 

ISaGRAF User’s Manual: 

https://www.icpdas.com/en/download/show.php?num=333  

 

ISaGRAF FAQ: 

https://www.icpdas.com/en/faq/index.php?kind=280#751 

 

WP-8000 (Hardware) Manual: 

https://www.icpdas.com/en/download/show.php?num=461 
 

 

 

Related Products: 
 

 Industrial Ethernet Switch:  

http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+

Ethernet__Switch 
 
 

 RS-232 to RS-422/485 Converter:  

http://www.icpdas.com/en/product/guide+Industrial__Communication+Serial__Communication+

Converter 

 
 
 Power Supply :  

http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply 
 
 

 High Profile I-8K/87K Series I/O Modules 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86

amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile) 

 

 

 

 

 

 

 

https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf
https://www.icpdas.com/en/download/show.php?num=333
https://www.icpdas.com/en/faq/index.php?kind=280#751
https://www.icpdas.com/en/download/show.php?num=461
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
http://www.icpdas.com/en/product/guide+Industrial__Communication+Serial__Communication+Converter
http://www.icpdas.com/en/product/guide+Industrial__Communication+Serial__Communication+Converter
http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile)
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile)
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I/O Modules Selection Guide 

WP-8x47 support only the I-8K / I-87K High Profile I/O modules and RS-485/FRnet remote I/O modules. 

Please refer to ICP DAS website: 

 

 

 

 

 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__

+I-8K_I-87K__Software__Support 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

www.icpdas.com 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
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Specifications: WP-8147/8447/8847 

Refer to WP-8x47 data sheet: http://www.icpdas.com/en/download/show.php?num=2919 

 

 

 

 
 

http://www.icpdas.com/en/download/show.php?num=2919
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Refer to WP-8x47 data sheet: http://www.icpdas.com/en/download/show.php?num=2919 

http://www.icpdas.com/en/download/show.php?num=2919
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Chapter 1 Typical Application 

1.1 Redundant Communication System 

 RS-485 or Ethernet redundant communication mechanism/applications.  

 For XP-8x37-CE6 and WP-8x47 series. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-119 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

 

 

 
 

WinPAC 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq119.pdf
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1.2 Redundant System - Ethernet I/O 

 If one Ethernet cable is broken or damaged, the other one will still handle the Ethernet I/O and 

exchange data with the other redundant PAC.  

 The scan of Ethernet I/O is much faster than that of RS-485 I-7K or I-87K I/O. 

 For XP-8x37-CE6 and WP-8x47 series. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-093 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 

WinPAC 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq093.pdf
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1.3 Redundant System - RS-485 I/O 

 If one Ethernet cable of WP-8x47 is broken or damaged, the other one will still work. 

 If one PAC is dead, the other one will take over the control of the RS-485 I/O. 

 PC/HMI can connect to this redundant system by one or two active IP. 

 For XP-8x37-CE6 and WP-8x47 series. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-093、FAQ-125、FAQ-138 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

WinPAC 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq093.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq125.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq138.pdf
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1.4 Modbus Master: RTU, ASCII, RS-232/485/422 

 Support up to 10 ports: 

COM1 ~ COM4 & COM5 ~ COM14 (if I-8112iW/ 14W/ 14iW/ 42iW/ 44iW in Slot0 ~ 2). 

 Can link to Modbus PLC or M-7000 I/O or Modbus devices.  

(Power meter, temperature PAC, inverter etc.) 
 

 

 

 

 

 

 

 

 

 

 

 

 

1.5 Modbus Master: TCP/IP  

 Each WP-8x47 supports to link to max. 100 Modbus TCP/IP Slave devices. 

 Support various Standard Modbus TCP/IP Slave devices. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-113 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq113.pdf
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1.6 Modbus Slave: RTU/TCP 

 Modbus RTU (RS-232/485/422): max. 5 ports. 

 Modbus TCP/IP: max. 32 connections. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.7 Communicate with Other TCP/IP Server or UDP Client/Server Devices  
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1.8 Multiple Web HMI – Monitor & Control Everywhere! 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.9 Send Email with One Attached File 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-067 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq067.pdf
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1.10 Data-Recorder & Data-Logger 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.11 Remote I/O Application 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-001、FAQ-050 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PC can load the data file stored in the 

WP-8xx7’s Flash Disk or microSD card by ftp 

or by Web HMI. 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq001.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq050.pdf
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1.12 SMS: Short Message Service  

 Short message can be sent in multiple language format (like Chinese, English... others) 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-111 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.13 As a Modbus Gateway for the Remote I/O Modules 

 The ISaGRAF PACs with Ethernet port: 

can be a Modbus RTU or a Modbus TCP/IP gateway of I-7000 & I-87K Series I/O modules.    

 

 The ISaGRAF PACs without Ethernet port: 

can be a Modbus RTU gateway of I-7000 & I-87K Series I/O modules. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq111.pdf
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1.14 Motion Control 

 One I-8091W can control 2 axes: X-Y plane, or 2 axes independent 

 Two I-8091W can control 4 axes:  X-Y plane + 2 axes independent, or 4 axes independent 

 Encoder Modules:  

I-8084W: 4-axis, without Z-index 

I-8090W: 3-axis 

I-8093W: 3-axis 

 

 

 

 

 

 

 

 

 

 

 

1.15 Stress Monitoring Application of Constructions 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-091、FAQ-128 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq091.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq128.pdf
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1.16 Fast FRnet Remote I/O 

 Advantage of FRnet I/O: Fast I/O scan: About 3 ms/scan.  

It depends on your program’s PLC scan time. E.g., if the ISaGRAF program’s PLC scan time is about 

9 ms, then the scan time for all will be 9 ms, not 3 ms. 

 Support FRnet DI, DO, AI and AO I/O modules. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-082、FAQ-154 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.17 Integrate with CAN/CANopen Devices & Sensors 

 WP-8x47 supports max. 10 I-7530 modules (RS-232 to CAN Converter) 

 Support I-8123W CANopen Master card, too. (FAQ-145) 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-086、FAQ-145 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq082.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq154.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq145.pdf
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq086.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq145.pdf
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1.18 VIP Communication Security 

 Set VIP (Very Important IP No.) for Modbus TCP/IP security. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.19 ISaGRAF PAC Connects the Smart Power Meter 

 Support standard Modbus protocol, support multiple RS-485 ports to connect to multiple PM-213x 

Smart meters 

 PM-213x is a series of 3 Phase/4 Loops 1 Phase Compact Smart Meter with true RMS energy and 

power parameters measurement in compact size. The ISaGRAF PACs combining with PM-213x can 

apply to various control/monitor systems about intelligent electric power measurement. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-129 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq129.pdf
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1.20 ZigBee Wireless Solution 

 The ISaGRAF PAC plus ZB-2550P and ZB-2551P RS-232/RS-485 Converters can apply wireless 

communication, reduce the wiring cost, and achieve the mission of remote I/O control and data 

acquisition. 

 Please refer to https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-110 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq110.pdf


 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         1-13 

1.21 GPS Application: ISaGRAF PAC Plus I-87211W & GPS-721 

 WP-8x47, iP-8x47, and μPAC-7186EG can support one I-87211W (slot 0 to 7) or I-87211W / GPS-721 

as RS-485 remote GPS I/O. 

 For doing auto-time-synchronization and getting local Longitude and Latitude. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-107 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq107.pdf
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1.22 Data Exchange: Ebus 

 Ebus ( Ethernet Network) 

Each ISaGRAF PAC can use its Ethernet port to talk to each other via the Ebus communication 

mechanism. When PC is talking with PACs via Ethernet, the PACs can also talk to each other via the 

same Ethernet; It makes the configuration more flexible and faster. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.23 Detect Hot-Swap I-87K (High Profile) I/O Status  

 In ISaGRAF Workbench, you must connect the I/O board to the "I/O connection" windows correctly 

and select the "io_state" board then you can observe the I/O status. When you Hot-Swap the I-87K 

(High Profile) I/O, the message will show on the front panel of ISaGRAF PAC. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

file:///D:/1now/0_ISaGRAF/2_Getting_Started/common_file/application-notes.htm%23ap-f_ebus
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1.24 Database Application  

 Supports SQL Client functions to write data to (or read data from) Microsoft SQL Servers (2000 SP3, 

2005, 2008). 

 One PAC can connect max. 4 Servers. 

 The PAC supports Multi-Language (depends on the model number), include Traditional Chinese 

Simplified Chinese, English, French, German, Italian, Portuguese, Russian, Spanish and others. 

 Integrating Machine-Business Automation Application. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-135 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq135.pdf


 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         1-16 

1.25 HART Solutions  

 ISaGRAF PAC support I-87H17W modules to communicate with other HART Devices.  

(Driver version- WP-8x47: 1.35) 

 ISaGRAF PAC support I-87H17W modules in its main control unit only (WP-8x47: slot 0 ~ 7). They 

don't support I-87H17W modules plugged in the RS-485 remote I/O expansion unit.  

 I-87H17W provides eight Analog Input channels to measure 4 to 20 mA current input. It also can be 

used as 8-ch HART communication ports. 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-136 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq136.pdf
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1.26 3G/4G Wireless Application 

 The XP-8x37-CE6 and WP-8x47 can communicate with remote Server by 3G/4G wireless modem.   

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-143,  151, 153 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.27 Measure Humidity and Temperature Values via DL-100TM485 

 More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-156   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq143.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq151.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq153.pdf
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq156.pdf
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Chapter 2 Software Installation 

2.1 Step 1 - Installing the ISaGRAF Software  

The following software must be installed before programing for ISaGRAF PAC system. 

http://www.icpdas.com/en/download/show.php?num=368 

 

 A. ISaGRAF Workbench 

 B. ICP DAS Utilities for ISaGRAF 

 

User has to purchase at least one pcs. of ISaGRAF Workbench Version 3 (ISaGRAF-256 ver. 3.4x or 3.5x) 

to install on his PC to edit, download, monitor & debug the PAC system.  

 

Operating system Requirements: 

One of the following computer operating systems must be installed on the target computer system 

before you can install the ISaGRAF Workbench software program. 
 

 Windows 95 / Windows 98 / Windows 2000 

 Windows NT Version 3.51 or Windows NT Version 4.0 

 Windows XP or Vista or XP mode in Windows 7 (refer to FAQ-117) 
 

Steps to Installing the ISaGRAF Workbench: 

 

If your operating system is Windows Vista or Windows 7 (32-bit), refer to 2.1.4. 

If your operating system is Windows 7 (64-bit), refer to 2.1.5. 

 
 
Since 2020, ICP DAS no longer provides ISaGRAF Workbench CD.  Please download the software on 

ISaGRAF Download Center and extract the zip file. Then, double-click on the "ISaGRAF.exe" file to start 

the installation process.

Select the language.  

http://www.icpdas.com/en/download/show.php?num=368
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq117.pdf
file:///D:/Work_2020/6_ISaGRAF/GS/v2.0/ip-8xx7_getting_started_en.doc%23_2.2:_Step_2_-%20Installing%20The%20ICP%20DA
file:///D:/Work_2020/6_ISaGRAF/GS/v2.0/ip-8xx7_getting_started_en.doc%23_Window_7_(64-bit)
https://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=isagraf
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After the installation, click the Windows “Start” and point to “Programs” and “ISaGRAF 3.5”, then click 

“Project” to open the ISaGRAF. 

 

 

 

 

 

 

 

 

 

2.1.1 The Hardware Protection Device (Dongle & USB Key-Pro) 

You must install the hardware protection device (dongle) provided with the ISaGRAF software on your 

computers parallel port to for the ISaGRAF program to achieve fully authorized functionality.  
 

While using ISaGRAF and the dongle is plugged well, if the “Help” – “About” says “Maximum number of 

IO variables: 32”, it means ISaGRAF workbench cannot find the dongle well. Please reset your PC and 

then check the “Help” – “About” again. 

 

 

 

 

 

 

 

 

 

 

 

 

If it still displays “Maximum number of IO variables: 32”, the driver may not be installed well. Please do 

the following steps. 

 

Dongle Protection: 

Execute the following drivers in the ISaGRAF installation folder and restart the PC.  

 For ISaGRAF-80: \Sentinel5382\setup.exe or  

 For other versions:  \Sentinel\setup.exe  

 

USB Key-Pro Protection: 

1.  To make your PC recognize the ISaGRAF USB protection-key, un-plug the USB protection-key from 

your USB port first, then run “\Sentinel\SSD5411-32bit.exe” in the ISaGRAF installation folder after 

you have installed the ISaGRAF. Then reset your PC.  
 

2.  Before executing ISaGRAF Ver. 3.5x, plugging the USB protection-key in the USB port on the PC. 

 

1. 

 

2. 
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2.1.2 Important Notice for Window 2000 Users 

If you close some ISaGRAF windows, it holds about 20 ~ 40 seconds (No response). This may be caused 

by the procedure “CTFMON.EXE” of Windows 2000. First click on “Ctrl & Alt & Del” at the same time to 

stop the “CTFMON.EXE” process, and then you may create a short cut for the “ISaGRAF project 

manager”. And then check on “run in separate memory space” option in the shortcut property. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

2.1.3 Important Notice for Window NT Users 

If your computer is using the Windows NT operating system, you will need to add one line to the “isa.ini” 

file in the ISaGRAF Workbench “EXE” subdirectory.  

C:\ISAWIN\EXE\isa.ini 

You can use any ASCII based text editor (such as Notepad or UltraEdit32) to open the “isa.ini” file.  

Locate the [WS001] header in the “isa.ini” initialization file (it should be at the top of the file). Anywhere 

within the [WS001] header portion of the “isa.ini” initialization file, add the entry shown below within 

the [WS001] header:  
 

[WS001] 
NT=1 
Isa=C: \ISAWIN 
IsaExe=C: \ISAWIN\EXE 
Group=Samples 
IsaApl=c: \isawin\smp 
IsaTmp=C: \ISAWIN\TMP 
 

2. 

 

1. 
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2.1.4 Important Notice for Windows Vista or Windows 7 (32-bit) Users 

Before installing the ISaGRAF; If your operating system is Windows Vista or Windows 7 (32-bit), change 

the User Account Control settings to avoid some of the setup restrictions. 

 

How to disable “UAC” (User Account Control)?  

 

The “UAC” (User Account Control) setting requires administrator-level permission.  

 

1. From the “Start” menu, choose “Control Panel > User Accounts and Family Safety > User Accounts”, 
then click “Change User Account Control settings” or “Turn User Account Control on or off”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. After clicking, it will show up the screen as below. 
 

 

Windows Vista: 

Uncheck the option – “Use User Account Control (UAC) to help you protect your computer” and then 

click on “OK”. 
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Windows 7: 

Move the slider down to “Never Notify” and then click on “OK”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Reboot your computer to apply the change. 

4. After rebooting, refer to section  2.1 Installing the ISaGRAF Software. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

file:///D:/Work_2020/6_ISaGRAF/GS/v2.0/ip-8xx7_getting_started_en.doc%23_Step_1_-
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2.1.5 Important Notice for Windows (64-bit) Users 
 

Because the ISaGRAF Workbench can only be installed on a 32-bit version of Windows operating system, 

users can use the following ways to create a proper installation environment for the ISaGRAF 

Workbench 3.55. If using Windows XP Mode that can be installed on 64-bit version of Windows 7 

Professional, Enterprise, and Ultimate editions. If using VMware Workstation/Player that can be 

installed on any 64-bit version of Windows OS (e.g., Windows 7 or Windows 8).  

 

Using Virtual PC and XP Mode: 
 

1. Download Windows Virtual PC and Windows XP Mode installers from the Windows Virtual PC Web 

site (http://go.microsoft.com/fwlink/?LinkID=160479) 

2. Double-click on "WindowsXPMode_nn-NN.exe” (where nn-NN is the locale, e.g. en-US) and follow 

the instructions in the wizard to install Windows XP Mode. 

3. Double-click on "Windows6.1-KB958559-x64.msu” to install Windows Virtual PC. 

4. Reboot your computer. 

5. After rebooting, click on "Star > All Programs > Windows Virtual PC” and then click Windows XP 

Mode. 

6. Follow the instructions in the wizard to complete Windows XP Mode Setup and Configuration.  

Note: It is important to remember the password provided during the installation, which is used to 

log on to the virtual machine. 

7. Now, go back to Section 2.1 to install the ISaGRAF.  

 

Using VMware Workstation/Player: 

1. Download and install VMware Workstation 10 (trail version) on VMware website. 

https://my.vmware.com/web/vmware/info/slug/desktop_end_user_computing/vmware_workstation/10_0 

2. Create a virtual machine running Windows XP (32-bit, SP3). 

3. Install ISaGRAF Workbench 3.55 on a virtual machine. 

4. Install ISaGRAF I/O Library on a virtual machine. 

5. The related settings for a virtual machine. 

6. Install USB dongle driver on a virtual machine. 

More at https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-174 

 

 

 

2.1.6 Important Setting for Using Variable Arrays 

 
Please add two more lines on the top of the c:\isawin\exe\isa.ini file to enable the usage of 
variable arrays. 

 
[DEBUG] 

Arrays=1 

 

 

 

http://go.microsoft.com/fwlink/?LinkID=160479
file:///D:/Work_2020/6_ISaGRAF/GS/v2.0/ip-8xx7_getting_started_en.doc%23_2.1_Step_1
https://my.vmware.com/web/vmware/info/slug/desktop_end_user_computing/vmware_workstation/10_0
https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq174.pdf
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Step 2 - Installing the ICP DAS Utilities for ISaGRAF 

Visit to the website to download the latest version of “ICP DAS Utilities for ISaGRAF” (io_lib.zip).  
http://www.icpdas.com/en/download/show.php?num=368 

 
 

The “ICP DAS Utilities for ISaGRAF” consists of 3 major items.  

 I/O libraries (for all ISaGRAF PAC) 

 Modem_Link utility  

 Auto-scan I/O utility 

 

 

Note: 

Make sure you have already installed the ISaGRAF Workbench program, IF NOT, refer to 

 Chapter 2.1 Step 1 before continuing. 

 

Execute setup.exe and follow the instructions of the InstallShield Wizard to install ISaGRAF Utilities.  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

http://www.icpdas.com/en/download/show.php?num=368
file:///D:/Work_2020/6_ISaGRAF/GS/v2.0/ip-8xx7_getting_started_en.doc%23_2.1:_Step_1_-%20Installing%20The%20ISaGRA
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Chapter 3 Setting Up a Web HMI Demo 

Important Notice:  
 

1. Only set a fixed IP address for the WP-8x47. (No DHCP) 

2. Disable the LAN2 port of the WP-8x47 If you are not using it. 

 
 

3.1 Web Demo List  

Visit the ISaGRAF Demo page to download these demo programs. 

http://www.icpdas.com/en/download/show.php?num=1005 

 

Demo list: 

Name Description IO board 

sample A Web HMI sample No I/O board 

example1 A simple example listed in Chapter 4 slot 0: I-87055W 

wphmi_01 Display PAC's date & time No I/O board 

wphmi_02 DI & DO demo slot 0: I-87055W 

wphmi_03 Read / Write Long, Float & Timer value No I/O board 

wphmi_04 Read / Write PAC's String No I/O board 

wphmi_05 Multi-Pages  demo: Page menu is on the Left slot 0: I-87055W 

wphmi_05a Multi-Pages  demo: Page menu is on the Top slot 0: I-87055W 

wphmi_06 AIO demo, scaling is in ISaGRAF 
slot 2: I-87024W 

slot 3: I-8017HW 

wphmi_07 AIO demo, scaling is in PC 
slot 2: I-87024W 

slot 3: I-8017HW 

wphmi_08 download PAC's file to PC slot 0: I-87055W 

wphmi_09 pop up an alarm window on PC slot 0: I-87055W 

wphmi_11 Trend curve. 
slot 2: I-87024W 

slot 3: I-8017hW 

wphmi_12 
Record the voltage of channels 1 to 8 of the I-8017HW 

every 50ms and draw trend curve by MS Excel 

slot 3: I-8017hW 

slot 2: I-8024W 

wphmi_13 
Record the voltage of channels 1 to 4 of the I-8017HW 

every 10ms and draw trend curve by MS Excel 

slot 3: I-8017hW 

slot 2: I-8024W 

 

 

 

 

 

http://www.icpdas.com/en/download/show.php?num=1005
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3.2 Steps to Set Up a Web HMI Demo 

3.2.1 Step 1 - Setup the Hardware 

 

A. Prepare one WP-8147/8447/8847 and then plug one I-87055W module in its slot 0.   

If you don’t have the I-87055W (8 IN & 8 OUT board), using the “wphmi_01” demo not “wphmi_05” 

and follow the same steps as below. 

 

B. Prepare one VGA monitor, one USB mouse and one Ethernet cable and then connect them to the 

WP-8x47. Also, the software keyboard can be used on the bottom-right of the PAC screen. 

 

C. Power the WP-8x47 up. 

 

 

3.2.2 Step 2 - Setting the Web Options 

 

A. Refer to Appendix A.3 to set a fixed IP address to the WinPAC. (No DHCP) 

 

B. Run ISaGRAF Driver and check the “Enable Web HMI” option and then click the “Setting” button. 

Next, check the “Enable Account Security” and click the “Edit” button to set the username and 

password. Then, click “OK” to exit the window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  If “Enable Account Security” is not checked, any users can easily get access to your WinPAC 

through the Internet Explorer. 

 

 

1. 

2. 

3. 4. 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         3-3 

3.2.3 Step 3 - Download ISaGRAF Project  

If you are familiar with how to restore the “wphmi_05.pia” program to ISaGRAF Workbench and how to 

download the project to the WP-8x47, go ahead to Section 3.2.4.   

 

If not, make sure that ISaGRAF Workbench has been installed on the PC (refer to Section 2.1 & 2.2) 

before conducting with the following steps.  

 

Visit the ISaGRAF Demo page to download the demo program. (…\isagraf_winpac_demo\wphmi_05.pia) 

http://www.icpdas.com/en/download/show.php?num=1005 

 

I-87055W (8 inputs and 8 outputs) I/O module is needed for using the wphmi_05 demo. If there is no 

I-87055W, downloading the wphmi_01 demo (…\isagraf_winpac_demo\wphmi_01.pia). 
 

 

Steps to Back Up & Restore an ISaGRAF Project: 

For archiving purposes, you can "Back Up" and "Restore" an ISaGRAF project. For example, you want 

someone to test your program or email it to service@icpdas.com for ICP DAS’s technical service. 

 

Backing Up an ISaGRAF Project 

1. Open the “ISaGRAF Project Management” window. On the Tools menu, point to Archive, and then 

click Projects. 

2. In the Archive-Projects window, click Browse to designate where you want to save the ISaGRAF 

project (e.g., ‘C:\Demo’). Also, check the Compress box if you want to reduce the size of the file. 

3. In the Workbench section, choose the project you want to back up. 

4. Click Backup to store the file to the specified location (e.g., ‘C:\Demo\example1.pia’). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. 

 

4. 

 

2. 

 

Click on the project to be backed up 
 

Click to reduce file size 

 

The path of backup file 
 

1. 

 

http://www.icpdas.com/en/download/show.php?num=1005
mailto:service@icpdas.com
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Restoring an ISaGRAF Project 

Follow the same ways as noted before to open “Archive Projects” window, and restore the ISaGRAF 

project from the backup location.  

 

1. In the Archive section, choose the project you want to restore. 

2. Click Restore to restore the file to the ISaGRAF Workbench. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Steps to Download an ISaGRAF Project to the PAC: 

Double-click on the “wphmi_05” to get into the project. Then click on “Link setup”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

 
2. 
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Click on “Setup” first and then entering the IP address of your PAC. The port number should be 502. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To download “wphmi_05” project to the WP-8x47, Click on “Debug”. If communication is established, 

click on “stop” first to stop the old project that is running on the PAC. Then click the “Download” button 

to download the project to the PAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the project is not compiled, click on 

“Make application code” button first, 

then, click on the “Debug”. 

Stop an existing project in the PAC 

and then download a new one. 
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3.2.4 Step 4 - Download Web Pages to the WinPAC 

 

A. Please copy all files in the demo folder (...\isagraf_winpac_demo\wp_webhmi_demo\wphmi_05\*.*)  

to the WP-8x47 's  \Miscro_SD\Temp\HTTP\WebHMI\  

 

When using wphmi_05 demo, it requires to plug one I-87055W in the slot 0 on the PAC. If you don’t 

have the I-87055W (8 inputs and 8 outputs) I/O module, you may download “wphmi_01”.  

 

B. Once the Web Pages are modified or new copied, run “rs_wphmi.exe” to reset the Web server. The 

“rs_wphmi.exe” must be run every time when the user has modified any file in the WP-8x47 ’s 

\Micro_SD\Temp\HTTP\WebHMI\ 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.5 Step 5 - Show Time  

 

Please run Internet Explorer (Rev. 6.0 or higher), key in the IP address of your WP-8x47.  For example:  

192.168.1.232   or   http://192.168.1.232 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://192.168.1.232/
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Chapter 4 Programming A Web HMI Example 

This chapter shows you how to build a simple ISaGRAF project and Web HMI pages.  

 

The WinPAC-8xx7/WP-8x47 is the abbreviation of the WinPAC-8147/8447/8847/8137/8437/8837. 

The WinPAC-8xx6/WP-8xx6 is the abbreviation of the WinPAC-8146/8446/8846/8136/8436/8836. 

 

 

 

 

Important Notice:  
 

1. WP-8x47 supports only I-8K and I-87K High profile I/O modules in slots 0 to 7.  

 

For more information about available modules, visit the webpage: 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support

__+I-8K_I-87K__Software__Support 

 

2. Please always set a fixed IP address to the WP-8x47. (No DHCP) 

 

3. Recommend to use Industrial Ethernet Switch for WinPAC. 

 

For more information about the Ethernet switch, visit the webpage: 

http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+

Ethernet__Switch 

 

 

If the user would like to program WP-8x47 by using both ISaGRAF and EVC++ (or VS.net), it is also 

possible. Please refer to Chapter 6 or Chapter 7. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch
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4.1 Writing a Simple ISaGRAF Program 

We are going to use ISaGRAF Workbench to write a simple ISaGRAF program, then download it to the 

WP-8x47 (with one I-87055W I/O module in its slot 0) to make it work. If you haven’t installed 

“ISaGRAF” & “ICP DAS Utilities for ISaGRAF”, go back to read chapter 2. 

 

This example contains one Ladder program. “example1.pia” resides at “…\isagraf_winpac_demo\”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Variables declaration: 

 

Name Type Attribute Description 

OUT01 Boolean Output Output 1 in the I-87055W, Modbus network address = 1 

OUT02 Boolean Output Output 2 in the I-87055W, Modbus network address = 2 

K1 Boolean Input Input 1 in the I-87055W, Modbus network address = 11 

K2 Boolean Input Input 2 in the I-87055W, Modbus network address = 12 

T1 Timer Internal 
Time Period of blinking, initial value set as T#8s 

Modbus network address = 21 

 

 

Ladder Logic Program Outline: 

 

 

 

Project name – "example1" 

 

Group name ("Test") for projects 

 

 

LD project name ("LD1") 
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4.1.1 Open ISaGRAF - Project Management 

 

Click the Windows "Start" > "All Programs" > "ISaGRAF 3.5" > "Projects" as shown below. 

 

 

 

 

 

   

 

 

 

 
 
 
 

4.1.2 Creating an ISaGRAF User’s Group 

 

Click the "Select project group" and the "New group" buttons, then enter the name for the new user 

group, and click "OK". Then, select the new group name and click the “Select” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1. 

2. 

3. 
4. 

5. 
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4.1.3 Creating a New ISaGRAF Project 

To start a new ISaGRAF project, click the "Create New Project" button and enter the name for the new 

project, then click OK.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Also, click "Edit" and "Set Comment Text" to add notes for the project. 

 

 

 

 

 

 

 

 

 

 

 

 

The new project will be displayed in the "Project Management" window. Double-click on the project 

name to open the project. 

 

 

 

 

 

 

 

 

 

 

 

 

Double-click on the project name to 

get into the project window. 
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4.1.4 Declaring the ISaGRAF Project Variables 

First, you must declare the variables that will be used in the ISaGRAF program.   

 

Declare the Boolean Variables 

1. To begin this process, click the "Dictionary" button.  

2. Click the "Booleans" tab to declare the Boolean. 

3. Double-click the first blank row below the "Booleans" tab to open the "Boolean Variable" window.  

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Please refer to ch4.1 Variables declaration) 

4. As the figure below, enter a name in the Name field (e.g., "K1").   

5. Add notes in the Comment field (e.g., " Input 1 in the I-87055W board ").  

6. Set the attribute for the "K1" variable (e.g., "Internal").   

7. Click the "Store" button to save it. A new Boolean variable has now been declared. 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

2. 

3. 

4. 

 
5. 

 

6. 

 

7. 
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NOTE:   

Make sure that each variable has the proper attribute assigned. Also, you can double-click the variable 

name to change the setting. 

 

Follow the similar steps as noted to add the Boolean variable – “K2”. The result will be shown as follows. 

 

 

 

 

 

 

 

 

 

 

 

Quick way to declare 

There are two outputs used in this example program named "OUT1 and OUT2". ISaGRAF provides a 

quick and easy way to declare like variables that are sequentially ordered. To begin this process,  

 

1. Click the "Quick Declaration" button.  

2. Enter in the output number that you will start with the "Numbering" in “from” and "To" fields  

(this example uses from 1 to 2).   

3. Enter the name for the output variables being declared. 

4. Set the attribute to "Output" and then click "OK". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

 

2. 

 

3. 

 

4. 

 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         4-7 

All two outputs have been added to the "Global Booleans" window. Click the "Save" button to save the 

settings. 

 

 

 

 

 

 

 

 

 

 

 

 
Declare the Timer Variables 

To declare the timer (T1) variable used in this example program:  
 

1. Click the "Timers" tab in the setup screen and double-click on the blank row. 

2. Enter the Name as "T1" and set the "Attributes" to "Internal". 

3. Set the "Initial Value" to "T#8s", then click on the "Store" button.  

4. Click the "Save" button and click on “X” to close the window. 
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4.1.5 Assign Modbus Network Address No. to Variables 

 

The Web HMI can exchange the variable value with the ISaGRAF project if they have assigned the proper 

“Modbus network address”. The Web HMI only recognize Modbus No. from 1 to 1024. However other 

SCADA software may R/W the Modbus No. from 1 to 8191 in the WP-8x47. 

 

Variables without assigning Modbus No. will not be available by Web HMI and other SCADA software or 

HMI devices.  

 

For more details about assigning Modbus network address, refer to section 4.1 & 4.2 of the ISaGRAF 

User Manual. Download the file at http://www.icpdas.com/en/download/show.php?num=333. 

  

1. Click on “Dictionary” icon. 

2. Click [Tools] > [Modbus SCADA addressing map]. 

3. Select [Options] > [Decimal], or the address will be displayed in hexadecimal format by default. 

4. Click the address “00001” and double-click the “OUT01” variable to set its Modbus address to 1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

2. 

3. 

4. 

5. 

http://www.icpdas.com/en/download/show.php?num=333
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Follow the same way to set the Modbus address for OUT01 (address =2), K1 (address =11), K2 (address 

=12), and T1 (address =21). Then we have below window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Very Important:  

When using Long integer or Float or Timer variables, two Modbus address numbers are required.  

 

For more details about Modbus network address, refer to section 4.2 of the ISaGRAF User Manual. 

Download the file at http://www.icpdas.com/en/download/show.php?num=333. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The Modbus addresses displayed 

here are in hexadecimal format. 

http://www.icpdas.com/en/download/show.php?num=333
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4.1.6 Create the LD Program - "LD1"  

 

ISaGRAF will run every program one time in each PLC scan cycle. Programs in the “begin” area will run 

first, then the “Sequential” area, and last the “End” area. An ISaGRAF cycle runs in the way as the below 

scheme. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the "Create New Program" button and the "New Program" window will appear.  Next, enter the 

program name (e.g., "LD1") and select "Quick LD:  Ladder Diagram" in the Language field. Make sure 

that "Begin:  Main Program" is selected in the Style field. Also, add notes in the Comment field if 

necessary. 

 

 

 

 

 

 

 

 

 

 

 

 

Now we have one program inside this project. Double-click on the “LD1” to get into it. 

 

 

 

 

 

 

 

 

 

Scan all inputs 

 

Process ‘Sequential’ area 

Process ‘begin’ area 

 

Process ‘End’ area 

 

Refresh all outputs 

 

ISaGRAF 

Cycle 
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4.1.7 Edit the "LD1" Program 

 

In the “LD1” program window, click "Insert Rung" from the Edit menu.  

 

 

 

 

 

 

 

 

 

 

 

 

Or, just click the "F2 (Contact on the Left)" button and the screen will be shown as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

We are going to write the first line of the LD1 program. Click the first "contact" and then click the "cut" 

button to delete it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the "Contact” and then click 

the "cut" button to delete it. 
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Click the "F6 (Block on the left)" button to create a block on the left of the "coil". 

 

 

 

 

 

 

 

 

 

 

 

 

Now we are going to choose a function block. Double-click anywhere inside the block and the "Function 

Block" window appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the "BLINK" function block and click OK. Also, click the Info button for more information about the 

function.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Double click on anywhere 

inside the block 

 

1.

. 

2. 

Click on "Info" for more 

details about the function. 
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Double-click on the left of the "CYCLE" parameter, select “Timer” from the drop-down menu, and then 

double-click "T1" to specify this variable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Double-click the "coil", select "Boolean" from the drop-down menu, and then double-click the “OUT1" 

variable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

2. 

3. 

1. 
2. 

3. 
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Now, you have done the LD1 program, click the "Save" button to save settings and then close the 

window. 

 

 

 

 

 

 

 

 

 

 

 

 

4.1.8 Connecting the I/O 

In Section 4.1.4, “OUT01” and “OUT02” variables are declared as “output” attribution, while “K1” & “K2” 

as “input” attribution. These "Input " & "Output" variables should be mapped to I/O channels on the 

PAC before they can work.  

 

To do that, click the “I/O connection” button and then double-click the first slot (i.e., slot0). Make sure 

that I-87055W module is plugged in the slot 0 of the WP-8x47. Check the “Equipments” item and 

double-click the “I_87055: 8 CH. DI & 8 CH. DO”, then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. 

1. 

Click “Note” to see 

more description. 

 3. 

4. 
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 If you don't have the I-87055W module, you may click the “Real / Virtual board” to make it becomes a 

virtual board. 

 

 

 

 

 

 

 

  

 

 

Mapping input variables “K1” & “K2” to input channels 1 & 2 of the “i_87055” board, click on “DI8” and 

double-click on the channel 1 and then click “Connect” twice to connect “K1” and “K2”. Also, click Close 

to close the window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

1. 
2. 

3. 

4. 
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By the same way, connect “OUT01”, “OUTPUT02” to output channel 1 to 2. Then we have below 

window. Click on “Save” and then exit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Important Notice:   

 

1. In the I/O connection window, slots 0 to 7 are reserved for mapping to I/O modules used on the PAC. 

Using slot 8 or above for additional I/O functionality. 

 

2. All of the variables with the "Input" or "Output" attribute must be linked to the I/O function board 

to ensure that the program compiles successfully.  Only variables with either "Input" or "Output" 

attributes will be displayed in the "I/O connection" window. In this example, two Boolean output 

variables (i.e., OUT01 and OUT02) and two Boolean input variables (i.e., K1 and K2) will be displayed. 
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4.2 Compiling & Simulating the Example Project 

For the ISaGRAF program can work properly on the PAC, the user must choose the correct ISaGRAF 

"Compiler Options", i.e., the "ISA86M:  TIC Code for Intel" option. 

 

To begin the compilation process, first click on the "Make" option from the main menu bar, and then 

click on "Compiler Options" as shown below. 

 

 

 

 

 

 

 

 

 

 

 

Make sure that three items illustrated in the figure below are selected and then click the "OK" button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: 

When using “Variable Array” in the program, DO NOT check the 2nd , 7th , 8th and 9th Optimizer 

options, or the value of the variable array will be incorrect.  

 

Recommend to check only the first option– “Run two optimizer passes”. 

2. 

6. 

Make sure to check these items. 

3. 

4. 

5. 

1. 
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Time to Compile the Project! 

Now that you have selected the proper compiler options, click the "Make application code" button to 

compile the project.  If there are no compiler errors detected during the compilation process, 

CONGRATULATIONS, you have successfully completed our example program.   

 

 

 

 

 

 

 

 

 

 

 

 

If errors are detected during the compilation process, just click on the "Continue" button to review the 

error messages. Return to the Project Editor and correct the errors as outlined in the error message 

window. 

 

Time to Simulate the Project! 

If the compilation is Ok, you may simulate the project on the PC to see how the program works without 

the PAC. To do that, click on the “Simulate” icon. 

 

 

 

 

 

 

 

 
 

 

Then, you can see the "I/O Simulator", "ISaGRAF Debug Programs", and "ISaGRAF Debugger" window.  

If I/O variables are not displayed in the simulating window, select the “Variables names” item from the 

Options menu to show the variable name. 
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In the "ISaGRAF Debug Program" window, double-click the "LD1" to see the status of the simulation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Running the Simulation Program 

When you open the "LD1" program, the outputs “OUT01” is blinking every 8 seconds. You can adjust the 

"T1" variable while the program is running.  To accomplish this, 

 

1. Click on the "Dictionary" button to open the "ISaGRAF Global Variables" window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click on “Timer” tab and then double-click on “T1”. 

 

 

 

 

 

 

Click “X” to exit 

the simulation. 
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3. Set the timer value to “T#4000ms” (i.e., 4000 ms) and click the “Write” button. Then, “OUT01” will 

be blinking every 4 seconds. 

 

 

 

 

 

 

 

 

 

Now we are going to simulate the “K1” & “K2” input. Click on the “K1” (or “K2”) button.  

 

 

 

 

 

 

 

 

 

 

To exit simulation, close the debugger window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Close the window to stop simulating. 
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4.3 Download & Debug the Example Project 

There are two ways to download the project to the PAC. One is using Ethernet cable, the other one is 

using RS-232 cable. Here will describe the RS-232 way. Also, refer to Section 3.2.3 for using the Ethernet 

way.  

 

Wiring the Hardware 

To begin this process, set up the hardware as below. Make sure the “Modbus RTU Slave Port” is set as 

COM3, refer to Appendix A.2, or it can only be download via Ethernet. 

 

The Pin Assignments of RS-232 cable: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: The WP-8147 doesn't have COM3. Only WP-8447 / 8847 have. 

 

 

The following explained how to download the ISaGRAF program to the PAC by using RS-232 cable. If the 

user would like to use an Ethernet cable, refer to section 3.2.3. 
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Setup Link Parameters 

Click the "Link Setup" button in the "ISaGRAF Programs" window.   

 

 

 

 

 

 

 

 
 
 
 
In the "PC-PLC Link parameters" window, set the communication parameters properly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The RS-232 communication parameters for the WP-8x47 MUST be set to the same serial communication 

parameters for the development PC. For WP-8x47, the default parameters for COM3 (RS-232) port are: 

 

 

 

 

 

 

Also, refer to Appendix A.2 to setup COM3 as Modbus RTU Slave port. 

 

 
 

Baud rate:  19200 

Parity: none 

Format: 8 bits, 1 stop 

Flow control: none 

NET-ID of the WP-8x47.  

The default setting is “1”.  

 1.  

COM port of the PC. 

2.  

Click it to set PC’s parameters. 

 

3.  

The parameters should be the same with the PAC. 

Defaults are 19200, N, 8, 1, No flow control. 

4. 
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Downloading the Example Project 

Before downloading the project to the PAC, make sure that the communication between the PAC and PC 

is functional. To do that, click the "Debug" button in the "ISaGRAF Programs" window. 

 

 

 

 

 

 

 

 

 
 

If the PC is communicating with the PAC, you can see the project name in the “Debugger” window. 

 

 

 

 

 

 

 

 

 
 

If the message in the "Debugger" window says "Disconnected", which means the PAC is unable to 

communicate with PC. 

 

The most common causes for this problem is either the serial port cable not being properly configured, 

or the development PC’s serial port communications DO NOT match that of the PAC. Check the wired 

cable on both sides and refer to the previous section to modify the COM port settings in the ISaGRAF 

"Serial Link Parameters" window. 
 

If there is a project already in the PAC before downloading the project. Click the "Stop application" 

button to halt the project. 

 

 

 

 

 

 

 

Then, you can start to download the “Example1” project to the PAC. 

 
 
 

 

The ISaGRAF project on the PC. 

The ISaGRAF project that is running on the PAC. 
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Starting the Downloading Process 

Click on the "Download" button in the "ISaGRAF Debugger" window. 

 

 

 

 

 

 

 

 

Then click the "ISA86M:  TIC Code For Intel" compiler option. 

 

 

 

 

 

 

 

 

 

 

Click the Download button to download the project to the WP-8x47.  A progress bar will display to show 

the project downloading progress. 

 

 

 

 

 

 

 

 

After successful downloading, the window displays as follows. 

 

 

 

 

 

 

 

 

 

 

 

 
 

If “ISA86M: TIC code fort Intel” is not found 

here, which means the compiler option - 

“ISA86M: TIC code for Intel” is not checked. 

Refer to section 4.2 to tick the option and 

re-compile the project again. 

Click on “X” to stop the communication 

between the PC & the PAC 
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Running the Example LD Program 

The user can observe the I/O status while the project is running. The way is to click the "I/O Connection" 

button in the ISaGRAF “Debug Programs” window. The user may set DI channels 1 or 2 of the I-87055W 

module to ON or OFF, and to see if the “K1” or “K2” status (TRUE/FALSE) is updated in time.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Moreover, click the “Dictionary” button to see the real-time state for Boolean and Timer variables. 
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Also, the user can open LD program to observe the running states in the "Quick LD Program" window.   
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4.4 Design the Web Page  

After finishing the ISaGRAF project and downloading it to the WP-8x47, we are going to design the Web 

Page for this ISaGRAF project. If you haven’t practiced “Setting Up a Web HMI Demo” listed in the 

Chapter 3, it’s better to do it once to get familiar with it. 

 

We will use “Microsoft Office FrontPage 2003” (or advanced version) to build web pages in this manual. 

User may choose any web page editor to do the same thing. 

 

You may refer to the finished web pages of this example in the WP-8x47 demo folder at design time. 

However, it is better to do it one time by yourself to get more understanding. 
 

Download the demo: http://www.icpdas.com/en/download/file.php?num=5495 

WP-8x47 demo folder: ...\isagraf_winpac_demo\wp_webhmi_demo\example1\ 

 

 

4.4.1 Step 1 – Copy the Sample Web HMI Pages 

This is a sample Web HMI pages in the WP-8x47 demo folder: 

   ...\isagraf_winpac_demo\wp_webhmi_demo\sample\ 

 

Please copy this “sample” folder to your drive and rename it, for example, “example1”. 

The basic Web HMI files include 2 folders and 3 DLL files and 4 HTM files as below. 

 

./img/ (default image files - *.jpg , *.bmp, *.gif ) 

./msg/ (default message files – wincon.js & xxerror.htm) 
  

whmi_filter.dll (three DLL files) 

login.dll 

main.dll 
  

index.htm (first default page) 

login.htm (the Web HMI welcome page) 

menu.htm (the page-menu page, normally on the left on the Internet Explorer) 

main.htm (first page when successfully login) 

 

User may put his own image files into the folder named as “user_img”. And put user-defined java script 

file or CSS file into the folder named as “user_msg”. Other folder name is not acceptable by the WinPAC 

Web HMI. 

 

The “index.htm” file is the default main page of the web server. User should not modify it. The 

“index.htm” re-directs to the “login.htm” file in 1 to 2 second when someone visits the WP-8x47 via the 

Internet Explorer. 

 

User may modify the “login.htm”, “menu.htm” & “main.htm” to fit his own need. We will only modify 

the “main.htm” in this example. 

http://www.icpdas.com/en/download/file.php?num=5495
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4.4.2 Step 2 – Building the Main.htm 

 

Execute the Microsoft Office FrontPage 2003 (or advanced version) and open the “main.htm”. 

 

Click on the “Design” page.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Layer from the Insert menu to insert a “Layer2” layout object as below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click these three items to represent the 

different panes of the workspace. 

Object ID – “Layer2” 
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Click inside this “Layer2” and click Layer from the Insert menu to add a new layer inside it, then enter 

“K1”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Follow the same steps to insert a “Layer” below the “Layer3” as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Place the “Layer4” below the “Layer3”. 

1. 

2. 

Add a layer inside the Layer2 

and enter “K1”. 

3. 
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Inside the “Layer4”, we are going to insert one image file to it as below. The image file name is 

“./img/big_Tcircle_red0.jpg”. Please browse to the correct folder in your hard drive. Here we use 

“example1/img/” in this example. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

You will see a window as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click inside the “Layer4”. 
2. Insert an image. 

1. 

2. 

Layer2 Layer3 

Layer4 

Layer1 
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Follow the similar steps to insert one “Layer5” and one “Layer6” with a “K2” symbol inside it, and also a 

“Layer7” with a “OK” symbol inside it as below. We will use “K1” to display the state of the first input of 

the I-87055W board, and “K2” for its second input. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Follow the similar steps to insert “OUT01” & “OUT02” as below.  

The OUT01 uses “./img/circle_blue0.jpg” as its image source, while OUT02 using “./img/cmd0.jpg”.   

We will use OUT01 to display the state of the first output of the I-87055W board, while “OUT02” is for 

controlling and displaying the second output of the I-87055W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

Layer5 1. Click here to insert a “Layer5”. 
2. Follow the same way to insert “Layer6” 

and “Layer7” inside the “Layer5”. 
Layer6 

2. 

Layer7 

Layer11 

Layer12 

Layer13 

Layer8 

Layer9 

Layer10 
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Now insert one another “Layer14”.  Inside the “Layer14” insert one “Layer15” with a “T1 = xxx ms” 

symbol. And two empty Layers – “Layer16” & “Layer17” just below the “Layer15”. We will use T1 to 

display the Timer value “T1” in the ISaGRAF project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on “Save” to save this page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Layer14 

Layer15 

Layer17 
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4.4.3 Step 3 – Adding Control Code to the Main.htm  

 

Click the Code tab to view the HTML code for the Web page. A valid HTML document will contain the 

following basic objects. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to the <body> area and then modify the code as below. 

 

 

 

 

 

<!-- Caption --> 

<font color="blue" size="4">    

<div style="position: absolute; width: 353px; height: 24px; z-index: 1; left: 73px; top: 12px" id="layer1"> 

This is a Web HMI sample page !</div> 

</font>   

 

 

 

 

 

<html> 

 

<title>Your Title here</title> 

 

<head> 

 

<SCRIPT LANGUAGE="JavaScript"> 

 

</SCRIPT> 

 

</head> 

 

<body> 

 

</body> 

 

</html> 

 

The “body” area describes the 

behavior of this page. 

 

JavaScript code is normally 

placed inside the “head” area. 

 

Refer to Chapter 5 for more details about Web HMI’s source code. 

Caption Area:  Layer1 

A Layer is starting with <div> and ending with </div> tag 
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<div style="position: absolute; width: 102px; height: 93px; z-index: 2; left: 75px; top: 52px" id="layer2"> 

<div style="position: absolute; width: 44px; height: 24px; z-index: 1; left: 3px; top: 10px" id="layer3"> 

K1</div> 

<div style="position: absolute; width: 58px; height: 46px; z-index: 2; left: 1px; top: 38px" id="layer4"> 

<img   name= “B11”  border="0" src="img/big_Tcircle_red0.jpg" width="43" height="41"></div> 

<p>&nbsp;</div> 

 

 

 

 

 

 

 

<div style="position: absolute; width: 101px; height: 93px; z-index: 3; left: 241px; top: 51px" id="layer5"> 

<div style="position: absolute; width: 47px; height: 26px; z-index: 1; left: 6px; top: 4px" id="layer6"> 

K2</div> 

<div style="position: absolute; width: 92px; height: 35px; z-index: 2; left: 7px; top: 38px" id="layer7"> 

 

<font  id=“font_B12” color=“blue” size=“3”> 

<b  id=“B12”> OK </b> 

</font> </div> 

 

<p>&nbsp;</div> 

 

 

 

 

 

 

 

 

<div style="position: absolute; width:82px; height:79px;z-index:4; left:71px; top:168px" id="layer8"> 

<div style="position: absolute; width: 60px; height: 31px; z-index: 1; left: 3px; top: 6px" id="layer9"> 

OUT01</div> 

<div style="position: absolute; width: 37px; height: 31px; z-index: 2; left: 6px; top: 42px" id="layer10"> 

<img  name=“B1”  border="0" src="img/circle_blue0.jpg" width="19" height="20"></div> 

<p>&nbsp;</div> 

  

K1 Area: Layer2 to Layer4 

Insert name= “B11” just after the "<img " 

K2 Area: Layer5 to Layer7 

 

modify “OK <div>” to become  

<font  id=“font_B12” color=“blue” size=“3”> 

<b  id=“B12”> OK </b> 

</font> </div> 

Insert name=”B11” just after the "<img " 

OUT01 Area: Layer8 to Layer10 
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<div style="position: absolute; width:100px; height:100px; z-index: 5; left:242px; top:164px" 

id="layer11"> 

<div style="position: absolute; width: 71px; height: 31px; z-index: 1; left: 4px; top: 8px" id="layer12"> 

OUT02</div> 

<div style="position: absolute; width: 61px; height: 48px; z-index: 2; left: 5px; top: 45px" id="layer13"> 

<img  style=“cursor:hand” name=“B2”  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])"  

border="0" src="img/cmd0.jpg" width="50" height="40"></div> 

 

   

 

 

 

 

<form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="B2"    type="hidden" value="0"> 

    <input name="END"   type="hidden"> 

  </form> 

 

<p>&nbsp;</div> 

  

 

 

 

 

 

 

 

 

 

 

<div style="position: absolute; width: 181px; height: 90px; z-index: 6; left: 374px; top: 162px" 

id="layer14"> 

<div style="position: absolute; width: 119px; height: 28px; z-index: 1; left: 4px; top: 7px" id="layer15"> 

 

 T1 = <b id="T1">xxx ms</b></div> 

 

 

 

<div style="position: absolute; width: 98px; height: 28px; z-index: 2; left: 4px; top: 45px" id="layer16"> 

 

 

 

OUT01 Area: Layer11 to Layer13 

After the “<img” tag, insert the following code: 

Style=“cursor:hand” name=“B2”  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])" 

Insert the following code: 

  <form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="B2"    type="hidden" value="0"> 

    <input name="END"   type="hidden"> 

  </form> 

T1 Area: Layer14 to Layer17 

Modify “T1 = xxx ms </div>” to become:  

T1 = <b id="T1">xxx ms</b></div> 
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  <form name="form_L21" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="L21" type="text" size="8" value="xxx">  

    <input name="END" type="hidden"> 

  </form> 

 

&nbsp;</div> 

 

 

 

 

 

 

 

<div style="position: absolute; width: 67px; height: 33px; z-index: 3; left: 106px; top: 44px" 

id="layer17"> 

  <input type="button" value="Enter" onclick="Check_L21( )"> 

 

&nbsp;</div> 

<p>&nbsp;</div> 

 

 

 

 

We have finished the code in the <body>   </body> area. 

 

Insert the following code inside the “Layer17”: 

<input type="button" value="Enter" onclick="Check_L21( )"> 

Insert the following code inside the “Layer16”: 

<form name="form_L21" method="post" action="./main.dll"> 

    <input name="BEGIN" type="hidden"> 

    <input name="L21" type="text" size="8" value="xxx">  

    <input name="END" type="hidden"> 

  </form> 
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Next, find out the “head” area and modify the code inside it as follows: 

 

// variable to record object's blink state，0: not blink，1: blink，For example: 

// ********************************* 

var B12_blink=0;  // init as 0: not blink 

// ********************************* 

 

// function to blink object 

var blink_step=0; 

function blink_obj() 

{ 

  if(blink_step==1) 

  { 

    blink_step=0; 

     

    // display your object here 

    // blink B12，For example: 

    // ********************************* 

    if(B12_blink==1) 

    { 

      B12.innerText="Error !" ;   

      font_B12.color="red"; 

    } 

    // ********************************* 

  } 

  else 

  { 

    blink_step=1; 

 

    // un-display your object here 

    // blink B12，For example: 

    // ********************************* 

    if(B12_blink==1) 

    { 

      B12.innerText="" ; 

      font_B12.color="red"; 

    } 

    // ********************************* 

  } 

  setTimeout("blink_obj()"，blink_period);    

} 

 

 

 

 

The “Error !” symbol will blink when the 

K2 = True in this example. Please 

un-mask the code inside these 3 areas. 
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Find out function Check_L21() and un-mask the sample code. function Check_L21() can be used to check 

the entered T1 value and post it to the PAC.  

 

// form sample，to check value of L21 & then post val to controller 

// For example: 

// ************************************************************** 

 

function Check_L21() 

{ 

  var val=form_L21.L21.value; 

  if(val>12000 || val<4000) 

  { 

    alert("T1's value should be in the range of 4000 to 12000"); 

    return; 

  } 

  Check(form_L21);  // post value to the controller 

} 

 

// ************************************************************** 

 

 

Moreover, find out function refresh_data() and insert the following code. 

 

// To refresh displayed data，this function is called by IE about every 1.5 sec later 

 

function refresh_data() 

{ 

  B1.src = "./img/circle_blue" + boolean_val[1] + ".jpg"; 

  B2.src = "./img/cmd" + boolean_val[2] + ".jpg"; 
 

  B11.src = "./img/big_Tcircle_red" + boolean_val[11] + ".jpg"; 
 

  if(boolean_val[12]==0) 

  { 

    B12.innerText="Ok"; 

    font_B12.color="blue"; 

    B12_blink=0; 

  } 

  else 

  { 

    B12_blink=1; 

  }   

  T1.innerText=timer_val[21] + " ms"; 

} 
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Now we have finished all the code. Please save it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You may click on “Preview” to simulate its run time behavior.  
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4.4.4 Step 4 – Download Web HMI Pages to the PAC  

 

The steps are similar as listed in Section 3.2. If you haven’t practiced “Setting Up a Web HMI Demo” 

listed in the Chapter 3, it’s better to do it once to get familiar with it. Then, start the PAC to do the 

following steps. 

 

 

First set the web options 

1. Run the ISaGRAF driver - “isaWinPAC”.   

2. On the Web page, check the “Enable Web HMI” option and click the “Setting” button. 

3. Check the “Enable Account Security” and click the “Edit” button to set the username and password. 

Then, click “OK”. 

 

Note: If “Enable Account Security” is not checked, any user can easily get access to your PAC through 

the Internet Explorer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

And then, copy all files in this example1 folder to the ISaGRAF PAC. 

 

Copy all files from: 

 <your hard drive>: \example1\ *.*   

 

Paste files to: 

 <ISaGRAF PAC>: Micro_SD\Temp\HTTP\WebHMI\  

 

 

1. 

2. 

3. 4. 
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Once the web pages are modified or new copied, run “rs_wphmi.exe” to reset the Web Server. Execute 

the “rs_wphmi.exe” file whenever any file stored in the WP-8x47’s folder \Micro_SD\Temp\HTTP\ 

WebHMI\ is modified. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Show Time: 

Run Internet Explorer (Rev. 6.0 or higher) and enter the IP address of the WP-8x47.   

For example:   61.218.42.10 or http://61.218.42.10 
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If there is something wrong with the web page.  You may enable the below item to display the debug 

message every time it has error. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

And also check if your ISaGRAF project already downloaded to the PAC? (Section 4.3 or  section 3.2.3). 

And do you assign the correct Modbus Network address to the respective ISaGRAF variables?  

(Section 4.1.5). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Double click here to display 

the error message. 

 

Check the item and click OK. 

Current running ISaGRAF project name is listed here. 
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Chapter 5 Web HMI Basics 

Important Notice:  

1. WP-8x47 supports only High profile I-8K and I-87K I/O cards in its slot 0 to 7.  

Visit the website, for more information about the supported modules:  

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support

__+I-8K_I-87K__Software__Support 

2. Only set a fixed IP address to the WP-8x47. (No DHCP) 

 

Note: 

1.  This chapter describes the programming basics for the Web HMI. We will not focus on the HTML 

basics. If you want to know more about the HTML programming, the best way is to “buy a HTML 

related book” from the bookstore. There are a lot of books doing this job.  

2.  The Web HMI only supports the basic HTML tags. It doesn’t support ASP, PHP or JSP or other Page 

Server language. 

3.  Please do not use <frameset> </frameset>, <frame> </frame> in the Web HMI.  

4.  The object name, object ID, code, variable name and function name is case sensitive. For example, 

refresh_data( ) and Refresh_data( ) is different. 

5.  There are more than ten Web HMI examples in the WP-8x47's demo folder. Refer to section 3.1. 

 

 

5.1 Basic Files for the Web HMI 

The basic Web HMI files include 2 folders and 3 DLL files and 4 htm files as below. 
 

./img/ (default image files - *.jpg , *.bmp , *.gif ) 

./msg/ (default message files – wincon.js & xxerror.htm) 
 

whmi_filter.dll (three DLL files) 

login.dll 

main.dll 
 

index.htm (first default page) 

login.htm (the Web HMI welcome page) 

menu.htm (the page-menu page, normally on the left on the Internet Explorer) 

main.htm (first page when successfully login) 
 

User may put his own image files into the folder named as “user_img”. And put user-defined JavaScript 

file or CSS file into the folder named as “user_msg”. Other folder name is not acceptable by the WinPAC 

Web HMI. 
 

The “index.htm” file is the default entry page of the web server. User must not modify it. The 

“index.htm” re-directs to the “login.htm” file in 1 to 2 seconds when someone visits the WP-8x47 via the 

Internet Explorer. 
 

User may modify the “login.htm”, “menu.htm” and “main.htm” to fit the requirement. 

http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
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5.2 Login.htm  

Login.htm is the first welcome page when a user visiting in. It can be modified. Below is the basic code 

for the login.htm 

 

<html> 

<head> 
 

<title>Login</title> 
 

<meta http-equiv=pragma content=no-cache>    
 

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" > 
 

<script language="JavaScript"> 

var random_val=123; 

function get_random_val() 

{ 

  var rightNow = new Date();   

  random_val += 323456789*rightNow.getMinutes() +  

                    107654321*(rightNow.getTime()%1000); 

  setTimeout("get_random_val()", 197); // repeat call 

} 
 

//check if username and possword are empty 

function validate(fm)  

{ 

  setKey(fm); 

  return true; 

}  
 

//Embed key whille submitting 

function setKey(fm) 

{    

  var rightNow = new Date();   

  cookieVal = random_val+rightNow.getTime(); 

  fm.key_.value = cookieVal;   

}     

 

</script> 
 

</head> 

This line is only for the “Login.htm”, please do not 

apply to other pages, for example, the “menu.htm” 

& “main.htm” & other .htm pages. 

Please apply your charset here. 

For example, 

English:  UTF-8 

Traditional Chinese: big5   

Simplified Chinese: gb2312 

or other language 
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<body onload="get_random_val()"> 

 

<div style="position: absolute; width: 332px; height: 34px; z-index: 5; left: 147px; top: 27px" 

id="layer1"> 

Welcome !</div> 

 

<div style="position:absolute; width:122px; height:38px; z-index:4; left: 171px; top: 95px;"  

id="layer2"> 

 

 

 

  <form name="form1" action="./login.dll" method="post"> 

     <input type="hidden" name="key_"> 

     <input type="submit" name="Submit" value="  Enter  " style="cursor:hand" onClick="return 

validate(this.form)">            

  </form> 

 

</div> 

  

</body> 

 

 

<!-- To ensure no-cache work --> 

<head> 

<meta http-equiv=pragma content=no-cache>    

</head> 

 

</html> 

 

 

 

 

 

That’s all the login.htm need. You can insert more images or text to it. Only remember to keep its basic 

code. 

 

 

 

 

 

get_random_val( ) should be always called at the 

beginning of the Login.htm . It is the entry point of 

the Login.htm 

 

Your caption is here. 

“form1” is necessary 

You may modify “Enter” to your own word. For 

example, “請進”. This may require user to modify 

the related “charset” at the beginning of this page. 

 

This code is only for the “Login.htm”, please do 

not apply to other pages, for example, the 

“menu.htm” & “main.htm” & other .htm pages. 
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5.3 Menu.htm  

Note: 

If you want to know more about the multi-page application, there are two demos in the WP-8x47 demo 

folder: ...\isagraf_winpac_demo\wp_webhmi_demo\wphmi_05 and wphmi_05a. The “wphmi_05” 

place its page-menu on the left, while “wphmi_05a” on the top.  

 

 

The “Menu.htm” defines the Page-menu of the Web HMI especially for the multi-page application. The 

page-menu can place only on the left or on the top.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the left: 

The width & scrolling 

can be modified. 

 
Width 

On the top: 

The height & scrolling 

can be modified. 

 

Height 
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Below is the basic code for the menu.htm 

 

<!-- top_or_left=1 , scrolling=0 , width=60 , resize=1 --> 

 

 

 

 

<html> 

<head> 

<title>Title1</title>    

 

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" > 
 

<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>    
 

<SCRIPT LANGUAGE="JavaScript"> 
 

function start1() 

{ 

  A_11(); 

} 

function refresh_data() 

{ 

  if(run_at_pc==1) return;  

} 

</SCRIPT> 
 

</head> 
 

<body onload="start1()"> 
 

<!-- Logout button --> 

<form name="form_logout" method="post" action="./login.dll"> 

  <input style="cursor:hand" name="CMD" type="submit" value="Logout" onClick="return 

logout(this.form)"> 

</form> 
 

</body> 

</html> 

 

 

 

 

 
 

The first row is not a comment, it defines the Page-Menu behavior 

top_or_left: 1: Top, 0: Left 

scrolling: 1: Yes, 0: No 

width: width of the Menu Frame, 0 – 999 (unit is pixel) 

resize:  1: Yes, 0: No 

Please apply your charset here. 

For example, 

English:  UTF-8 

Simplified Chinese: gb2312 

Traditional Chinese: big5   

or other language 

This row is necessary for 

menu.htm, main.htm & 

other multi-pages 

start1( ) is the entry point of the menu.htm 

 

form_logout is for the logout button. 
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5.4 Main.htm  

 

5.4.1 A Simple Main.htm Example  

Before going further in the main.htm, first take a look at a simple main.htm example. This example only 

displays a “Hello !” message when successfully login, nothing else. 

 

 

 

<html> 

<head> 

<title>Title1</title> 

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8" >   

 

<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>   

 

 

 

 

<SCRIPT LANGUAGE="JavaScript"> 

show_scroll_word(200,"Hello，Welcome to the Web HMI Sample !");   

 

 

function refresh_data() 

{ 

} 

 

</SCRIPT> 

</head> 

 

 

<body onLoad="init()"> 

 

 

<font color="blue" size="4">    

<div style="position: absolute; width: 353px; height: 24px; z-index: 1; left: 73px; top: 12px" id="layer1">   

Hello !</div> 

</font>    

 

 

</body> 

</html> 

 

 

 

Apply your charset here. For example, English: UTF-8, Simplified 

Chinese: gb2312, Traditional Chinese: big5, or other language. 

This line is necessary for menu.htm, main.htm & other multi-pages. 

Calling show_scroll_world( ) will display a moving word at the 

bottom of the Internet Explorer. Here 200 means 200 ms.  You may 

make it slower, for example, using 500. 

 

refresh_data( ) is called when the Internet Explorer has received the 

requested data from the controller. It is called in the period about 

1.25 to 5 seconds depends on the 

init( ) is the entry pint of the main.htm & other multi-pages. 

 

A layout object is starting with “<div>” and ending at “</div>” tags. 

Here only show a message “Hello !” 
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You may replace the above main.htm with the main.htm in the WP-8x47 demo folder:  

...\isagraf_winpac_demo\wp_webhmi_demo\sample   

 

Then, download it to the PAC (refer to section 4.4.4). You will see the below window when logging in 

successfully. 

 

 

 

 

 

 

 

 

 

 

 

 

User may try to plug out the Ethernet cable of the PAC or of your PC. You will see it show 

“Communication is temporary break now !” in about 10 seconds. When you plug the cable back, the 

communication will be recovered in about 10 to 45 seconds.  

 

 

 

 

 

 

 

 

 

 

 

 

 

If the communication broken time exceeds 120 seconds, it will show the below message. You have to 

close the Internet Explorer & open it again to re-login. 

 

 

 

 

 

 

 

 

 

 

A moving word is display here. This is because 

the action of calling show_scroll_world( ). 
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5.4.2 More About the refresh_data( ) Function and Dynamic Data 

Note: The code, variable name and function name is case sensitive. For example, refresh_data( ) is 

correct, however Refresh_data( ) is not correct. 

 

The refresh_data( ) function must always apply in the main.htm and other multi-pages. It is called when 

the Internet Explorer has received the requested data from the PAC. The calling period is about 1.25 to 5 

seconds depends on the communication quality 

 

The refresh_data( ) is often used for refreshing the dynamic data. For example, the Boolean value, 

integer value, timer value or float value of the variables in the ISaGRAF project. 

 

The Internet Explorer can access to the data in the ISaGRAF project only when they are assigned a 

unique Modbus Network Address No (refer to section 4.1.5). The Web HMI only accepts Network 

Address No in the range of 1 to 1024. IE browsers cannot receive data without a network address 

number (No. =0) or a number that is not within the permitted range (1 to 1024). 

 

The main.htm and other multi-pages can use the below variable array to access to the ISaGRAF data 

(case sensitive). The identifier appeared in the [] is the related Network Address No. For example, 

boolean_val[2] means the Boolean value of the ISaGRAF Boolean data which is assigned with the 

Network Address No. = 2. 

 

 

 

 

 

 

 

 
 

To access to long integer value (32-bit integer) use get_long_val( ) function. For example, 

get_long_val(11) , get_long_val(13) , get_long_val(15). 

 

 

 

 

 

Note:  

The long integer, timer and float variable’s Network Address No. must occupy 2 No. in the ISaGRAF 

project. Refer to section 4.2 of the ISaGRAF User Manual at 

http://www.icpdas.com/en/download/show.php?num=333  

 

This means that if you specify a network address as 11 for the Real or Timer or integer variable (32-bit 

values - greater than 32767 or less than -32768), the next address 12 can't be assigned to any variable.  

It must be specified from address 13. 

 

boolean_val boolean value in the ISaGRAF 

word_val word value in the ISaGRAF, -32768 to +32767 

float_val real value in the ISaGRAF, for ex, 1.234 , -0.456E-02 

timer_val timer value in the ISaGRAF, unit is ms, max = 86399999 (< 1 day) 

string_val message value in the ISaGRAF, max string length is 255 

get_long_val(  ) long integer value in the ISaGRAF,  

 -2147483648 to +2147483647 

http://www.icpdas.com/en/download/show.php?num=333
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5.4.2.1 Displaying Dynamic Boolean Data 
 

Demo example: whmi_02 and whmi_05 (section 3.1) 

Let’s look back to the refresh_data function. If user want to display the dynamic Boolean value, the 

below code can be used.  

 

… 

function refresh_data() 

 

{ 

  B1.src = "./img/circle_blue" + boolean_val[1] + ".jpg" ; 

} 

… 

 

<body onLoad="init()"> 

… 

<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 

<img name="B1" src="img/circle_blue0.jpg"></div> 

… 

</body> 

 

 

 
 
5.4.2.2 Displaying Dynamic Float & Word & Timer Data 
 

Demo example: wphmi_01 , wphmi_03 and wphmi_05 (section 3.1) 

If user want to display the dynamic float value, the below code can be used. 

… 

function refresh_data() 

{ 

  F21.innerText = float_val[21] ; 

} 

… 
 

 

<body onLoad="init()"> 

… 

 

<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 

<b  id="F21"> xxxx </b> </div> 

… 

</body> 

 

 

 

 

The action of the image object “B1” is defined here. 

if boolean_val[1]=1, it display image “B1” as “img/circle_blue1.jpg”. 

if boolean_val[1]=0, it display image “B1” as “img/circle_blue0.jpg”. 

 

The layout (or location) of the image object “B1” is defined here by 

the “<div” and “</div>” tags. 

The declaration of image “B1” is defined here by the “img” tag & 

name=”B1”    src= …     “src=” defines the initial value of B1 

The action of the Text object “F21” is defined here. 

If want to display Word data, please use “word_val[ ]“ 

If want to display Timer data, please use “timer_val[ ]“.  

For example, F21.innerText = timer_val[21] + “  ms”; 

The layout (or location) of the Text object “F21” is defined 

here by the “<div>”   “</div>” tags. 

The declaration of Text object “F21” is defined here by the “<b” tag & 

id=”F21”   & “</b>” tag       initial value of this F21 is  “xxxx” 
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5.4.2.3 Displaying Dynamic Long Integer Data 

 

Demo example: wphmi_03 and wphmi_05 (section 3.1) 

If user want to display the dynamic long integer value (32-bit format), the below code can be used. 

 

… 

function refresh_data() 

{ 

  L11.innerText = get_long_val(11) ; 

} 

… 

<body onLoad="init()"> 

… 
 

<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 

<b  id="L11"> xxx </b> </div> 
 

… 

</body> 

 

 

 

 

 

5.4.2.4 Displaying Dynamic String Data 

 

If user want to display the dynamic string value (max length is 255), the below code can be used. 

 
 
… 

function refresh_data() 

{ 

  S31.innerText = string_val[31] ; 

} 

… 

<body onLoad="init()"> 

… 

 

<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 

<b  id="S31"> empty </b> </div> 

 

… 

</body> 

 

 

 

The action of the Text object “L11” is defined here. 

The layout (or location) of the Text object “L11” is 

defined here by the “<div”  and   “</div>” tags. 

The declaration of Text object “L11” is defined here by the “<b” tag 

and  id=”L11”   and  “</b>” tag, the initial value of this L11 is  “xxx”. 

The action of the Text object “S31” is defined here. 

The layout (or location) of the Text object “S31” is 

defined here by the “<div”  and   “</div>” tags. 

The declaration of Text object “S31” is defined here by the “<b” tag 

and  id=” S31”   and  “</b>” tag , the initial value of this S31 is  “xxx”. 
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5.4.2.5 Trigger a Boolean Object to Blink 
 

Demo example: wphmi_02 and wphmi_05 (section 3.1) 
 

Some application may need a message to blink when the Boolean value changes. For example, If 

boolean_val[12] is False, it means “OK”. However, if boolean_val[12] is True, it means “Error !”. User 

may want to make this “Error !” blink to attract viewer’s attention. 

 

The below code can do this job. 

 

… 

var blink_period=500;   

 

setTimeout("blink_obj()", blink_period);     

 

var B12_blink=0;   // init as 0:not blink 

var blink_step=0; 

 

function blink_obj() 

{ 

  if(blink_step==1) 

  { 

    blink_step=0; 

     

    if(B12_blink==1) 

    { 

      B12.innerText="Error !" ;   

      font_B12.color="red"; 

    } 

     

  } 

  else 

  { 

    blink_step=1; 

 

    if(B12_blink==1) 

    { 

      B12.innerText="" ; 

      font_B12.color="red"; 

    } 

 
  } 

  setTimeout("blink_obj()", blink_period);    
} 

 

The blinking period, unit is ms 

Setup a timer to handle the blinking action 

Blink step 1: 

To display “Error !” in red color. 

1: to blink, 0: no blink 

Blink step 2: 

To display “” (nothing) in red color. 
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…function refresh_data() 
{ 

  if(boolean_val[12]==0) 

  { 

    B12.innerText="Ok"; 

    font_B12.color="blue"; 

    B12_blink=0; 

  } 

  else 

  { 

    B12_blink=1; 

  }   

} 

… 

<body onLoad="init()"> 

… 

 

<div style="position: absolute; width: 214px; height: 53px; z-index: 2; left: 102px; top: 79px"> 
 

<font  id=”font_B12” color=”blue” size=”3”> 

 

<b  id="B12">OK</b>  

 

</font> 

</div> 

</body> 

 

 

5.4.2.6 Displaying Float Value with Fixed Digit Number Behind the “.” Symbol 
 

Demo example: wphmi_06 and wphmi_07 (section 3.1) 
 

The float_str1(para1, para2) function can convert float value to a string with fixed digit number behind 

the dot "." symbol 
 

para1 is the float value to be converted, for ex, 1.234567 

para2 is the digit number behind the “.” dot symbol, 0 to 6 

for example, float_str1(1.234567, 3) return “1.234”,   

           float_str1(1.234567, 2) return “1.23” 

 

… 

function refresh_data() 

{ 

  F21.innerText = float_str1( float_val[21] , 3) ; 

} 

 

The layout (or location) of the Text object “B12” is defined 

here by the “<div” and  “</div>” tags. 

The “<font>“  & “</font>” tags can be used for controlling the 

font’s color and font’s size. 

Convert float val at Network Address 21 to a string with digit 

number = 3 behind the “.” dot symbol. 

The declaration of Text object “B12” is defined here by the “<b” tag 

and  id=”B12” and “</b>” tag,   the initial value of this B2 is  “OK” 

The action of the Text object “B12” is defined here. 

If boolean_val[12]=0, no blink.   

If boolean_val[12]=1, blink. 
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5.4.3 Post Data to the PAC 

The former section 5.4.2 listing how to get and display data from the PAC. This section focuses on 

posting data to the PAC, in other word to control the WinPAC via the Internet Explorer. 

 

To set a new value to the Boolean, word, long integer, float, timer and string variables in the ISaGRAF 

project, we need “form” object appeared in the main.htm or other multi-pages. A “form” object looks 

like as below. 

 

 

 

 

<form  name="form_L21"  method="post"  action="./main.dll"> 

  <input  name="BEGIN"  type="hidden"> 

  <input  name="L21"  type="text"  size="8"  value="xxx">  

  <input  name="END"  type="hidden"> 

</form> 

 

 

 

 

 

 

The “<input>” name to control the WinPAC’s data must follow below format. The number followed 

behind the first letter should be in the range from 1 to 1024. This number is point to the variable name 

in the ISaGRAF project with the same Modbus Network Address No.  

 

 

 

 

 

 

 

 

 

Note:  

The long integer, timer and float variable’s Network Address No. must occupy 2 No. in the ISaGRAF 

project. Refer to section 4.2 of “ISaGRAF User Manual: 

http://www.icpdas.com/en/download/show.php?num=333  

 

That means if you assign a Network Address No.= 11 to a Real type variable (or Timer or integer will 

have 32-bit value – larger than 32767 or smaller than -32768), the next No. 12 should not be assigned to 

any other variable in the ISaGRAF project. However, you may assign No.=13 to one another variable. 

 

 

B point to the ISaGRAF Boolean data, for ex, B5, B109 

W point to the ISaGRAF word data (-32768 to +32767), for ex, W9, W1001 

L point to the ISaGRAF long integer data (-2147483648 to +2147483647),  

 for ex, L21.  This “L” Also point to the ISaGRAF timer data 

F point to the ISaGRAF real data, for ex, F13, F235 

S point to the ISaGRAF message data, for ex, S18 

name of this form; method should be “post”; action should be “./main.dll” 

Inside the form, the first “<input>” 

must name as “BEGIN” (case sensitive) 

and type as “hidden”. 

 

Inside the form, the last “<input>” 

must name as “END” (case sensitive) 

and type as “hidden” 

 

All the other “<input>” appeared between 

“BEGIN” & “END” are the data to post to the PAC. 

 

http://www.icpdas.com/en/download/show.php?num=333
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5.4.3.1 Post Boolean Value to the PAC 
 

A. To post by the image  

… 
function ON_OFF (form_obj, obj, current_boo_value) 
{ 
  if(current_boo_value==0)   
  { 
    flag = confirm("turn ON ?"); 
    if(flag) obj.value=1; 
  }  
  else 
  { 
    flag = confirm("turn OFF ?"); 
    if(flag) obj.value=0; 
  } 
  if(flag) 
  { 
   if(GetUserID(form_obj)==true) form_obj.submit(); 
  }  
} 
function refresh_data() 
{ 
  B2.src = “img/cmd” + boolean_val[2] + “.jpg” ; 
} 
… 
 

<body onLoad="init()"> 
… 
 

<div style="position: absolute; width:100px; height:100px; z-index: 5; left: 242px; top: 164px" > 
 
 
 
 

<img style="cursor:hand" name="B2"  onclick="ON_OFF(form_B2, form_B2.B2, boolean_val[2])"   
src="img/cmd0.jpg"> 
 
 
 
 
 
 

 

<form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN"  type="hidden"> 

    <input name="B2"     type="hidden" value="0"> 

    <input name="END"    type="hidden"> 

</form> 

</div> 

… 
</body> 

Demo example: wphmi_02 and wphmi_05  

ON_OFF function is used for posting the current Boolean value 

to the PAC. 

The first parameter is the name of the “form”. 

The second parameter is the “<input>” name inside the form. 

The last parameter is the current Boolean value. 

 

Display the current boolean image. In this example, 

0: display “img/cmd0.jpg”, 1: “img/cmd1.jpg” 

The layout (or location) of the image object “B2” is 

defined here by the “<div>” and “</div>” tags. 

 

“cursor:hand” will display the mouse arrow as a hand when entering the image area. 

The onclick will call ON_OFF( ) when the mouse click on it. 

The first parameter is the name of the “form”. Here is “form_B2”. 

The second parameter is the “<input>” name inside the form. 

Here is “form_B2.B2”. 

The last is the current Boolean value. Here is boolean_val[2]. 

 

Name of the form 

 

Name of “<input>” inside the form. Here is “B2”. Because it is inside 

“form_B2”, then we must use the name of “form_B2.B2” to identify it. 
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B. To post by buttons 
 

function ON_(form_obj, obj) 
{ 
  flag = confirm("turn ON ?"); 
  if(flag)  
  { 
    obj.value=1; 
    if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function OFF_(form_obj, obj) 
{ 
  flag = confirm("turn OFF ?"); 
  if(flag)  
  { 
    obj.value=0; 
    if(GetUserID(form_obj)==true) form_obj.submit(); 
  } 
} 
function refresh_data() 
{ 
  B2.src = "img/big_Tcircle_red" + boolean_val[2] + ".jpg" ; 
} 
… 
 

<body onLoad="init()"> 
… 
<div style="position: absolute; width: 56px; height:40px; z-index: 5; left: 82px; top: 69px" > 
<img name="B2" src="img/big_Tcircle_red0.jpg"> 
</div> 
 

<div style="position:absolute; left:85px; top:124px; width:42px; height:27px;"> 
<input type="button" value="ON" style="cursor:hand" onClick="ON_(form_B2, form_B2.B2)">  
 
 
 
 

<form name="form_B2" method="post" action="./main.dll"> 

    <input name="BEGIN"      type="hidden"  value="">  

    <input name="B2"        type="hidden"  value="1"> 

    <input name="END"       type="hidden"  value="">  

</form> 

</div> 

 
 

<div style="position:absolute; left:85px; top:166px; width:47px; height:31px"> 
<input type="button" value="OFF" style="cursor:hand" onClick="OFF_(form_B2, form_B2.B2)"> 
</div> 
… 
</body> 
 

Demo example: wphmi_02 and wphmi_05  

ON_  function is used to post Boolean value as “True” to the  PAC. 

“OFF_  function is used to post Boolean value as “Fasle” to the PAC . 

 

The layout (or location) of the image object “B2” is defined here 

by the “<div” and  “</div>” tags. 

S 

Display the current Boolean image.  

0:  “img/big_Tcircle_red0.jpg”  ,  

1:  “img/ big_Tcircle_red1.jpg” 

 

A button to call ON_( ). First parameter is the name of the form. Here is “form_B2” 

The second is the name of the “<input>” inside the form. Here is “form_B2.B2” 

 

A button to call OFF_( ). First parameter is the name of the form. Here is “form_B2”. 

The second is the name of the “<input>” inside the form. Here is “form_B2.B2. 

Name of “<input>” inside the form. Here is “B2”. Because it is inside 

“form_B2”, then must use the name of “form_B2.B2” to identify it. 
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5.4.3.2 Post Word & Long & Float & Timer & String Value to the PAC 

… 

function Check(form_obj) 

{  

  flag = confirm("Are you sure?");  

  if(flag) 

  { 

    if(GetUserID(form_obj)==false) { return false; }   

    form_obj.submit(); 

    return true;  

  } 

  else 

  {  

    return false;  

  } 

} 
 

function refresh_data() 

{ 

  L15.innerText=get_long_val(15);    

  F17.innerText=float_val[17];    

} 

… 

<body onLoad="init()"> 

… 

<div style="position: absolute; width: 195px; height: 25px; z-index: 2; left: 45px; top: 52px" > 

L15 = <b id="L15">xxxx</b></div> 

<div style="position: absolute; width: 196px; height: 29px; z-index: 3; left: 45px; top: 82px" > 

F17 = <b id="F17">xxxx</b></div> 
 

<div style="position:absolute; left:47px; top:131px; width:204px; height:60px"> 

  <form name="form1" method="post" action="./main.dll"> 

    <input name="BEGIN"  type="hidden"  value="">  

    <input name="L15"    type="text"    value="Enter long val (L15)"> 

    <input name="F17"    type="text"    value="Enter float val (F17)"> 

    <input name="END"    type="hidden"  value="">  

  </form> 

</div> 

 

<div style="position:absolute; width:74px; height:31px; left: 234px; top: 150px;"> 

  <input type="button" style="cursor:hand" onClick="return Check(form1)"  value="Enter"> 

</div> 

… 
 

</body> 

 

Demo example:  

wphmi_03,  wphmi_04, wphmi_05,  

wphmi_06 and wphmi_07 

Display dynamic value here.  

If data is word, please use word_val[  ] 

If data is timer, please use timer_val[  ] 

If data is string, please use string_val[  ] 

“cursor:hand” will display the mouse arrow 

as a hand when entering the button area. 

Check( ) is used to post any “form”. 

Text input L15 & F17 inside the “form1”.  If data is 

timer, please use “L”; And “W” for word; “S” for string. 

When mouse click on this button, 

it calls Check( ) to post to the PAC. 

The layout (or location) of the text object “L15” & 

“F17” are defined here by the “<div>”   “</div>” 

tags. 
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5.5 Multi-Pages 

The Web HMI in the WP-8x47 supports multi-page application. You may refer to Chapter 3 to setup the 

multi-page demo – “wphmi_05” to see how it work. 

 

 

5.5.1 Level 2 and Level 3 Page  

 

The multi-page name can be any valid html file name. For example, “page2.htm”, “kitchen.htm”, 

“u2-page4.htm”.  
 

If “u2-” appear in front of the page name, the page will become a Level 2 page. For example, the 

“u2-Page4.htm” in the “wphmi_05” demo.  

 

If “u3-” appear in front of the page name, the page will become a Level 3 page. For example, the 

“u3-time.htm” in the “wphmi_05” demo. 
 

 

What is a Level2 page? Only the user login with the Middle or High priority can get access to it. To access 

to the Level3 page, users have to login as a High priority user. The page name without “u2-“ and “u3-“ is 

identified as Level 1 page. That means any user successfully login can access to it. For example: the 

“main.htm”. 

 

The other rules for multi-pages are almost the same as “main.htm” (section 5.4). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 

2. 

3. 4. 

Note:  

If “Enable Account Security” is not checked, 

any user can easily get access to your PAC 

through the Internet Explorer. 
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5.5.2 Switch One Page to One Another Page  

 

Please take a look at the “menu.htm” of the “wphmi_05” demo as below. The “goto_R_page( )” function 

can be used for switching to other page. 

 

<!-- top_or_left=0 , scrolling=0 , width=110 , resize=1 --> 
 

<html> 

<head> 

<title>Title1</title>    

<meta http-equiv="Content-Type" content="text/html; charset=big5" > 

<SCRIPT LANGUAGE="JavaScript" src="./msg/wincon.js"></SCRIPT>    
 

<SCRIPT LANGUAGE="JavaScript"> 

function start1() 

{ 

  A_11(); 

} 

function refresh_data() 

{ 

  if(run_at_pc==1) return;  // if simulate at the PC, just return 

  … 

} 

</SCRIPT> 

</head> 

<body onload="start1()"> 
 

<!-- Logout button --> 

<form name="form_logout" method="post" action="./login.dll"> 

  <input style="cursor:hand" name="CMD" type="submit" value="Logout" onClick="return 

logout(this.form)"> 

</form> 

<br/> 

<br/> 
 

<!-- Goto main.htm --> 

<A style="cursor:hand" onClick="goto_R_page('main.htm')">第1頁</A> 

<br/> 

<br/> 
 

<!-- Goto kitchen.htm --> 

<A style="cursor:hand" onClick="goto_R_page('kitchen.htm')">Kitchen</A><br/> 

<br/> 

<br/> 

 

Switch page to “main.htm” 

Switch page to “kitchen.htm” 

“cursor:hand” will display the mouse arrow 

as a hand when entering the button area. 
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5.6 Web Security 

There are some ways user can get access to the WP-8x47 via Ethernet port.  

 

1) Using Modbus TCP protocol at port No.= 502. (ISaGRAF & other HMI do this) 

2) Using FTP (for example, key in “ftp://10.0.0.103” on the Internet Explorer) 

3) Using Telnet (for example, key in “telnet 10.0.0.103 in the “command” window) 

4) Using the Web Server (The Web HMI does) 

 

For security concerns, untick options 2 and 3 on the Web page in the ISaGRAF Driver window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

And click the Settings... button to set the proper username & password for the Web HMI. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click it to disable. 

Click to set the user 

name & password. 
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About the method 1, user may set up to 8 IP address for ISaGRAF or other HMI to get access to the 
WP-8x47 via the Modbus TCP/IP protocol as below. 
 
On the ISaGRAF IO connection window, connect “vip” and enter the IP address which can get access to 

the WP-8x47 via Modbus TCP/IP protocol. If “vip” is not connected, any remote IP address can get 

access to your WP-8x47 via Modbus TCP/IP protocol. If “vip” is connected and No IP is set (all assigned 

as “N/A”), No TCP device can get access to it anymore. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please re-compile your ISaGRAF project and download it to the PAC if you have modified the IO 

connection. 
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Chapter 6 Using VB.net 2008 Program to Access ISaGRAF Variables 

Important Notice: 

Please store your application programs and data files in the \Micro_SD. Don't store them in the 

\System_disk. That is because the \System_Disk is using NOR Flash memory. Its size is small and the 

major purpose is for storing OS, ISaGRAF driver, some basic utilities and DLL.  

 

The NOR Flash memory is not good for frequently updating files. If update files frequently in the 

\System_Disk (e.g., update a file every 1 to 5 seconds, then it will be about ten thousand more updates 

in one day), the data or files in the \System_disk may crush or lost for some days or months later. 

 

 

This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008 

development tool. There are some sample programs in the WP-8x47 demo folder. 

 

WP-8x47 demo folder: ...\isagraf_winpac_demo\vb.net_2008_demo 

wp_vb01: Digital I/O demo with one I-87055W in slot 0 of the WP-8x47. 

wp_vb02: Analog I/O demo with one I-87024W in slot 1, one I-8017HW in slot 2. 

wp_vb03: Read/Write ISaGRAF internal integers, timers & real variables. (No I/O is needed) 

 

The name of ISaGRAF demo projects are "wp_vb01.pia", “wp_vb02.pia”, and "wp_vb03.pia" in the same 

directory. 

 
 
 
 

6.1 Create a New Project 

 

1. Open Microsoft Visual Studio .NET 2008 software and run the “New Project” from the “File” menu.  
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2. Check the “Smart Device” on the left, then selecting the “.NET frame work 2.0” and “Smart Device 

Project”. Entering a proper project name and the last click on “OK”.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 2.0”, 

then click on “OK”.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

1. 

2. 

3. 

4. 

5. 

1. 

2. 

3. 

4. 
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6.2 Add Project Reference for an Application  

The “QuickerNet” library contains all modules’ functions. Before you use the “Quicker” keyword in the 

program, you must add the “QuickerNet.dll” into the reference list of your application.   

 

1. Right click on the Project name on the right hand side, 

then select “Add Reference …”.    
 

2. Select the “mscorlib” in the list box and click the button 

“OK” (the component “mscorlib” must appear in the 

Selected Components area) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click the “Browse” button. Select the “QuickerNet.dll” from WP-8x47 demo 

folder: ...\isagraf_winpac_demo\vb.net_2008_demowp_vb01\vb01\ and click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right-click 
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4. When both “mscorlib” and “QuickerNet.dll” are added, double-click on “My Project” and click 

“References” to check if the “QuickerNet.dll” is well added. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.  Right-click on the “Form1.vb” and select “View Code” from the pop-up. Move cursor to top and 

insert the “Option Explicit On” and “Imports Quicker” in the first two statements.   

 

 

 

 

 

 

 

 

 
 

 

 

 

Then you can design all required objects and actions inside your VB Forms. 

 

 

 

 

 

 

 

 

 

 

 

1. 

2. 

Double-click 

Double-click 
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6.3 Compiling an Application Program  

When you have finished writing a program, you can build an application by the following steps.  

 

1. Remember to save at any time for safety. 

 

  

 

 

 

 

 

 

 

2. Then compile (Build) the project. The result is listed in the “Error List” windows at the bottom. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. You can find the execution file in   

<Your VB.net Project folder> \bin\Release\ <project_name>.exe 

Copy this execution file to the \System_Disk\ISaGRAF\ path in the WP-8x47 and  run it. 

 

 

Note:  

User may copy the VB.net execution file to other path to run it but there should contain at least 

“QuickerNet.dll”, “Quicker.dll”, and “Mscorlib.dll” three DLL files with it or it cannot run correctly. 

 

For example, the project1.exe can run in the \Micro_SD\ path if “QuickerNet.dll”, “Quicker.dll” and 

“Mscorlib.dll” are in it. These DLL files can be copied from the path “\System_disk\ISaGRAF\” in the PAC. 
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6.4 QuickerNET.DLL  

This section we will focus on the description of the application example of QuickerNET.DLL functions. 

There are some functions that can be used to R/W data from/to the ISaGRAF SoftLogic. The functions 

of QuickerNET.DLL can be clarified as two groups as depicted as below:  

 

1. Digital R/W Functions   

2. Analog R/W Functions 

 

 

6.4.1 Digital R/W Functions   

  

■ UserSetCoil 

 

Description:  

This function is to set the value to a Boolean variable by Modbus network address. 

 

Syntax:  

UserShare.UserSetCoil ( iUserAddress As System.UInt16, iStatus As byte)  

 

Parameter:  

iUserAddress: Specify the Modbus Network Address of Variable (1 to 8191) 

iStatus: Set the status. For instance, iStatus = 1 for True, iStatus = 0 for False 

 

Return Value:  

None  

 

Example:  

‘ Set the output variable of Modbus Network Address “1” to True.  

UserShare.UserSetCoil(Convert.ToUInt16(1), 1)  

 

Demo program:  

WP-8x47 demo folder:     ...\isagraf_winpac_demo\vb.net_2008_demowp_vb01 
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■ UserGetCoil 

 

Description:  

This function is to get the value from a boolean variable by Modbus network address. 

 

Syntax:  

UserShare.UserGetCoil ( iUserAddress As System.UInt16, ByRef iStatus As byte)  

 

Parameter:  

iUserAddress: Specify the Modbus Network Address of Variable (1 to 8191) 

iStatus: Get the variable status , iStatus = 1 for True, iStatus = 0 for False 

 

Return Value:  

None  

 

Example:  

‘ Get the variable status of Network Address “1”.  

Dim iStatus As Byte  

UserShare.UserGetCoil(Convert.ToUInt16(1), iStatus)  

 

Demo program:  

WP-8x47 demo folder:   ...\isagraf_winpac_demo\vb.net_2008_demowp_vb01 
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6.4.2 Analog R/W Functions 

■ UserSetReg_short ■ UserSetReg_long ■ UserSetReg_float 

 

Description:  

These functions are to set 16-bit short integer, 32-bit long integer & 32-bit float value to the specified 

Modbus network address. 

 

Syntax:  

UserShare.UserSetReg_Short (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 

Byte 

 

UserShare.UserSetReg_Long (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 

Byte 

 

UserShare.UserSetReg_Float (ByVal iUserAddress As System.UInt16, ByRef iStatus As Single) As 

Byte 

 

Parameter:  

iUserAddress: Specify the Network Address of Variable (1 to 8191) 

iStatus: Set the short or long integer or float value. 

 

Example:  

‘Set a long value “1234567” to the variable of Modbus Network Address “1”.  

UserShare.UserSetReg_long (Convert.ToUInt16(1), Convert.ToInt32(1234567))    

 

‘Set a short value “-1234” to the variable of Modbus Network Address “3”.  

UserShare.UserSetReg_short (Convert.ToUInt16(3), Convert.ToInt16(-1234))    

 

‘Set a float value “2.174” to the variable of Modbus Network Address “4”.  

UserShare.UserSetReg_float(Convert.ToUInt16(4), Convert.ToSingle(2.174))    

 

Demo program:  

WP-8x47 demo folder:   

1. ...\isagraf_winpac_demo\vb.net_2008_demowp_vb02 for R/W analog I/O 

2. ...\isagraf_winpac_demo\vb.net_2008_demowp_vb03 for R/W internal long integer, Timer and Real 

(floating-point) values. 

 

Note:  

In the ISaGRAF project, long integer, timer, or real variable must use 2 network address numbers.  

Refer to section 4.2 of “ISaGRAF User Manual: 

http://www.icpdas.com/en/download/show.php?num=333  

 

 

 

http://www.icpdas.com/en/download/show.php?num=333
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■ UserGetReg_short ■ UserGetReg_long ■ UserGetReg_float 

 

Description:  

These functions are to get 16-bit short integer, 32-bit long integer & 32-bit float value from the specified 

Modbus network address. 

 

Syntax:  

UserShare. UserGetReg_Short (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 

Byte 

 

UserShare. UserGetReg_Long (ByVal iUserAddress As System.UInt16, ByRef iStatus As Integer) As 

Byte 

 

UserShare. UserGetReg_Float (ByVal iUserAddress As System.UInt16, ByRef iStatus As Single) As 

Byte 

 

Parameter:  

iUserAddress: Specify the Network Address of Variable (1 to 8191) 

iStatus: Get the short or long integer or float value.  

  

Example:  

Dim float_val As Single 

Dim short_val As Int16 

Dim long_val As Int32 

  

‘Get float value of the variable of Modbus Network Address “7”.  

UserShare.UserGetReg_float(Convert.ToUInt16(7), float_val)  

 

‘Get long value of the variable of Modbus Network Address “9”.  

UserShare.UserGetReg_long(Convert.ToUInt16(9), long_val)  

 

‘Get short value of the variable of Modbus Network Address “11”.  

UserShare.UserGetReg_short(Convert.ToUInt16(11), short_val)  

 

Demo program:  

WP-8x47 demo folder:   

1. ...\isagraf_winpac_demo\vb.net_2008_demowp_vb02 for R/W analog I/O 

2. ...\isagraf_winpac_demo\vb.net_2008_demowp_vb03 for R/W internal long integer, Timer and Real 

(floating-point) values. 

 

Note:  

In the ISaGRAF project, long integer, timer, or real variable must use 2 network address numbers.  

Refer to section 4.2 of “ISaGRAF User Manual: 

http://www.icpdas.com/en/download/show.php?num=333  

   

http://www.icpdas.com/en/download/show.php?num=333
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Chapter 7 Using EVC++ Program to Access ISaGRAF Variables 

Important Notice: 

Please store your application programs and data files in the \Micro_SD. Don't store them in the 

\System_disk. That is because the \System_Disk is using NOR Flash memory. Its size is small and the 

major purpose is for storing OS, ISaGRAF driver, some basic utilities and DLL.  

 

The NOR Flash memory is not good for frequently updating files. If update files frequently in the 

\System_Disk (e.g., update a file every 1 to 5 seconds, then it will be about ten thousand more updates 

in one day), the data or files in the \System_disk may crush or lost for some days or months later. 

 

 

The user can write his EVC++ 4.0 application to access to the ISaGRAF variables running at the same 

WP-8x47 by using the below functions for Read/Write boolean, word, long and float value. 
 

 

The “Head file” and “library” at design time are “WinConAgent.h” and “Quicker.lib” that can be found in 

the WP-8x47 demo folder (…\isagraf_winpac_demo\evc++_lib\ ) on PC.  

 

The DLL at run time is the “Quicker.dll” which is in WP-8x47 's \System_Disk\isagraf\.  

(Please copy the execution file after successfully compilation to the WinPAC 's \System_Disk\isagraf\ 

and then run it.) 

 

 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         7-2 

Set Boolean value: 
 

unsigned char UserSetCoil(unsigned short iUserAddress, unsigned char iStatus); 

 

iUserAddress: 1 to 8191  (Variable’s network address in ISaGRAF project) 

iStatus:   0: set boolean to False,  1: set boolean to True 

 

for example:  UserSetCoil(100 , 1)  // set boolean at network addr 100 as True 

 

 

 

Set word or float or long value: 
 

unsigned char UserSetReg(unsigned short iUserAddress, long *iStatus, unsigned char iDType); 

 

iUserAddress: 1 to 8191 (Variable’s network address in ISaGRAF project) 

iStatus:   A pointer to a long type, which stores the data to set    

iDType 0: type is word  

 1: data type is float  

 2: data type is long (use long for Timer value in ISaGRAF, unit: ms) 

for example:   

  float   float_val; 

  long   word_val, long_val; 

  long   *temp_val; 
 

  //set word_val (-32768 to +32767) to ISaGRAF variable with network address 1 

  word_val = -20000 ; 

  temp_val = (long *)(&word_val); 

  UserSetReg(1 , temp_val, 0); 

 

  // set float_val to ISaGRAF variable with network address 2 

  float_val = 1.2345 ; 

  temp_val = (long *)(&float_val); 

  UserSetReg(2 , temp_val, 1); 

 

  // set long_val to ISaGRAF variable with network address 4 

  long_val = 12345678 ; 

  temp_val = (long *)(&long_val); 

  UserSetReg(4 , temp_val, 2); 
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Get Boolean value: 
 

unsigned char UserGetCoil(unsigned short iUserAddress, unsigned char *iStatus); 

 

iUserAddress: 1 to 8191 (Variable’s network address in ISaGRAF project) 

iStatus:   0: boolean is False,  1: boolean is True 

 

for example:   

  unsigned char bVal; 

  UserGetCoil(5 , &bVal)  // get boolean value at network addr 5 

 

 

Get word or float or long value: 

 

unsigned char UserGetReg(unsigned short iUserAddress, long *iStatus, unsigned char iDType); 

 

iUserAddress: 1 to 8191 (Variable’s network address in ISaGRAF project) 

iStatus:   A pointer to a long type, which stores the data returned    

iDType 0: type is word  

 1: data type is float  

 2: data type is long (use long for Timer value in ISaGRAF, unit: ms) 

 

for example:   

  float   float_val; 

  long   word_val, long_val; 

  long   ret_val; 
 

  //get word_val (-32768 to +32767) of ISaGRAF variable with network address 10 

  UserGetReg(10, &ret_val, 0); 

  if ( ret_val>=0  &&  ret_val<=32767 )  word_val = ret_val; 

  else  word_val = ret_val  |  0xFFFF0000; 
 

  // get float of ISaGRAF variable with network address 11 

  UserGetReg(11, &ret_val, 1) ; 

  float_val = *(float *) (&ret_val) ; 
 

  // get long of ISaGRAF variable with network address 13 

  UserGetReg(13, &ret_val, 2) ; 

  long_val = ret_val ; 

 

Note:  

In the ISaGRAF project, long integer, timer, or real variable must use 2 network address numbers.  

Refer to section 4.2 of “ISaGRAF User Manual: 

http://www.icpdas.com/en/download/show.php?num=333  

http://www.icpdas.com/en/download/show.php?num=333
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Chapter 8 Using InduSoft Project to Access ISaGRAF Variables 

Note:  

 

If the HMI program behavior is not so smooth or slow, refer to Appendix F. 

The WinPAC-8xx7/WP-8x47 is the abbreviation of the WinPAC-8147/8447/8847/8137/8437/8837. 

The WinPAC-8xx6/WP-8xx6 is the abbreviation of the WinPAC-8146/8446/8846/8136/8436/8836. 
 

Important Notice:  

 

1. Only set a fixed IP address to the WP-8x47/8xx6. (No DHCP) 

2. Recommend to use NS-205/208 or RS-405/408(Ring Switch) Industrial Ethernet Switch for WinPAC. 

3. For more information, refer to the ISaGRAF User Manual on the website: 

http://www.icpdas.com/en/download/show.php?num=333 

4. WinPAC-8xx6 supports InduSoft and ISaGRAF logic running in the same PAC.  

 

 

 

A simple example to run InduSoft & ISaGRAF logic in the same PAC: 
 

Step 1: Create a new ISaGRAF project as below. 
 

This demo uses a DI/O module I-87055W in slot 0 of WinPAC-8xx6, and an AO module I-87024W in slot 2 

and one internal variable defined as follow. 

 

ISaGRAF Variable Definition: 
 

Variable Type Name Network Address Comment Attributes 

Boolean DI_1 1 87055W DI channel 1 Input 

Boolean DO_1 11 87055W DO channel 1 Output 

Integers AO_1 21 87024W AO channel 1 Output 

Integers Internal 31 Internal variable Internal 

 

 

If you are not familiar with ISaGRAF, refer to section 4.1 to 4.3.  

 

http://www.icpdas.com/en/download/show.php?num=333
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I/O Connection Setting: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The ISaGRAF variables to be exchanged with InduSoft must be declared with a Modbus “Network 

Address” as below. 

 

 

 

 

 

 

 

 

 

 

Please save & compile the ISaGRAF 

project & then download to the PAC.  

If you are not familiar with ISaGRAF, 

refer to section 4.1 to 4.3.  

 

 

 

 

 

 

2. 

An empty Ladder is just fine 
1. 

3

. 

2. 

1. 

3. 

Please set No. as “Decimal” 

In this example, assign  

No. 1   to DI_1. 

No. 11 to DO_1 

No. 21 to AO_1 

No. 31 to Internal 
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Step 2: Create an InduSoft project. 

 

1. Select [File] > [New] from the “InduSoft Web Studio” main menu. 

2. Click on “Project” tab in the “New” window. Then type in the name for the new user’s project in the 

“Project name” and select “Windows Embedded Lite” in the “Product type”. Press “OK”.  

3. The “Project Wizard” window will appear. Select “Empty Application” on the “Template”,  

“320 x 240” on the “Resolution” and “None” on the “Shared Tags”. 

4. Then, the new project will show on the “Project Explorer” window as the figure. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

1. 

2. 

3. 

4. 
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Define application tags  

 

Select [Insert] > [Tag] on the main menu bar.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The “New Tag” window will show as below.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This demo uses a DI/DO module I-87055W, an AO module I-87024W and one internal variable defined 

as follow. Please create these tags one by one. 
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Create main screen  

1. Select the “Graphics” tab in the “Project Explorer” window. 

2. Click mouse right button in the file folder of “Screen” then the “Screen Attributes” window appears. 

3. Set up the screen attributes such as “Size”, “Location”, “Runtime Properties” and “Background 

Picture” then press “OK” to edit screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
4. Select “Text” icon, then clink on the main screen where want to establish a text and type 

“87055W_DI_1”.  

5. Select “Text” icon again following the previous text and type “#” then select “Text Data Link”.  

(# means 1 digit, #### means 4 digits, ###### means 6 digits.) 

 

 

 

 

 

 

 

 

 

 

 

4. Click on “Text” to add a 

label “87055W_DI_1”. 

 
5. Click on “Text” to add a “#” label, and then 

click on “Text Data Link”. “#” means the 

display Text has 1 digit. “####” means 4 digits. 

2. Right-click on “Screen” 

and click “Insert”. 

1. Click “Graphics” 

3. Set up the screen attributes. 
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6. Double click the “#” object and then type DI in the “Tag/Expression”. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Repeat former method to create other objects and click “Save” icon on the main menu to save this main 

screen page as “MainPage.scr”. (Select [File] > [Save As HTML] to create this screen that can be 

visualized in a remote station using a regular web browser.)  

 

Note: For the Output object, as 87024W_AO_1 and 87055W_DO_1, the “Input Enabled” of the “Text 

Data Link” should be checked as below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The main screen is created as below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Checking the box means user may 

input its value at run time.  

 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         8-7 

Create Modbus TCP workspace 
 

1. Click “Comm” tab in the “Project Explorer”. 

2. Click right mouse button on the folder “Drivers”, and select “Add/Remove drivers”. 

3. In the “Communication Drivers” window, click “MOTCP” driver then click “Select” and click “OK” to 

close this window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Expanding file folder of “Drivers” and it will show a file folder named “MOTCP”. Right-click on “MOTCP” 

and select “Insert” to add a workspace of Modbus TCP.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

3. Select the “MOTCP” DLL 

3. 
4. 

5. 

1. 

2. 
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When a Modbus TCP workspace “MOTCP001.DRV” appears, fill in following data as corresponding field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Data 

Type 

Sample 

Syntax 
Comments 

0X 0X:1 
Coil Status:  

Read and write events using Modbus instructions 01, 05, and 15 

1X 1X:5 
Input Status:  

Read events using Modbus instructions 02 

3X 3X:4 
Input Register: 

Read events using Modbus instruction 04 

4X 4X:5 
Holding Register:  

Read and write events using Modbus instructions 03, 06, 16 

FP FP:1 
Floating-point value (Holding Register):  

Read and write float-point values using two consecutive Holding Registers. 

DW DW:2 
32-bit Integer value (Holding Register):  

Read and write 32-bit integer values using two consecutive Holding Registers. 

Valid Range of Initial Address per Worksheet: Varies according to the equipment 

What does “127.0.0.1:502:1” mean? 

“127.0.0.1” is the local host IP address which 

means data is sent to the same PAC. “502” is 

the Modbus TCP/IP port No., the last “1” is the 

Net-ID of the PAC. 

1X: 0 is for reading “Boolean” data 

0X: 0 is for writing “Boolean” data” 

3X: 0 is for reading short “integer” data (16-bit integer, Word: -32768 to +32767) 

4X: 0 is for writing short “integer” data (16-bit integer, Word: -32768 to +32767) 

DW: 0 is for reading & writing long “integer” (32-bit integer, Double Word) 

FP: 0 is for reading & writing floating point data (32-bit REAL) 

 

For more details, please refer the table as below. 
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Please add the following 4 Modbus TCP workspace:  
 

DRV Name MOTCP001.DRV MOTCP002.DRV MOTCP003.DRV MOTCP004.DRV 

Description DI DO AO Internal 

Station 127.0.0.1:502:1 

Header 1X:0 0X:0 4X:0 3X:0 

Tag Name DI DO AO Interior 

Enable Read when Idle 1   1 

Enable Write on Tag Change  1 1  

Address 1 11 21 31 

 

When finished all setting, press “Ctrl + F4” to close all inside windows and save all files. 

 

Project Setting 

Select “Project -> Settings” to open “Project Settings” window. In the “Startup screen” edit box, fill in 

“MainPage.scr” then click “OK” to close this window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         8-10 

Web Thin Clients 

 

Select “Project -> Settings” to open “Project Settings” window. In the “Data Server IP Address”, type in 

the correct IP address of your PAC and click “OK”. 
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Download and run the project 

Select [Home] > [Connect] to open “Remote Management” window. In the “Network IP” of “Target 

Station”, type in the correct IP address of your PAC and click “Connect”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 
 

If connection is fine, click on the tab of “Project” then click “Download”. When download finished, click 

“RUN” to start the project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type in the IP address of PAC. 

The “Install system files” button can update PAC ’s Indusoft firmware to your 

PC’s current version. Please make sure all file attribution are not “read only” in 

the PAC's  \System_Disk\InduSoft\ path. 
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Configuration Web directory of WinPAC 

Run WinPAC Utility and change Web directory to “\System_Disk\InduSoft\Demo_01\Web”. Click 

“Change” and “Save and Reboot” to finish this configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Visualize your project in a remote station 

Run Internet Explorer and type the IP address of the WinPAC, e.g., “http://10.0.0.80/MainPage.html”.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://10.0.0.80/MainPage.html
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Chapter 9 Demo Program & FAQ 

The WinPAC-8xx7/WP-8x47 is the abbreviation of the WP-8147/8447/8847. 
 

For more information, refer to the ISaGRAF User Manual on the website: 

http://www.icpdas.com/en/download/show.php?num=333 
 

Demo Programs: (isagraf_winpac_demo.zip) 

http://www.icpdas.com/en/download/show.php?num=1005 
 

FAQ: 

https://www.icpdas.com/en/faq/index.php?kind=280#751 

 

 

9.1 Get On-Line Help  

If you have question, you may email to service@icpdas.com. 

 

On-line help of ISaGRAF standard functions & function blocks: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com/en/download/show.php?num=333
http://www.icpdas.com/en/download/show.php?num=1005
mailto:service@icpdas.com
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On-line help of ICP DAS add-on functions & function blocks: 
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On-line help of ICP DAS add-on I/O boards & I/O complex equipment: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On-line help of ISaGRAF languages: 
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9.2 Installing the ISaGRAF Programming Examples 

Visit the website to download the following files: 

 

ISaGRAF User Manual:   

http://www.icpdas.com/en/download/show.php?num=333 
 

Demo Programs: (isagraf_winpac_demo.zip) 

http://www.icpdas.com/en/download/show.php?num=1005 
 

FAQ: 

https://www.icpdas.com/en/faq/index.php?kind=280#751 

 

 

Example lists: 
 

Project Name Description I/O Boards (Notes) 

example1 A simple Web HMI example 

slot 0: I-87055W 
wp_vb01 

VB.net 2008 demo 01 for WP-8x47:  

DI/DO demo, refer to Chapter 6. 

wp_vb02 
VB.net 2008 demo 02 for WP-8x47: 

AI/AO demo, refer to Chapter 6.   

slot 1: I-87024W 

slot 2: I-8017HW 

wp_vb03 
VB.net 2008 demo 03 for WP-8x47:  

Read/Write long integer, float, and Timer, refer to Chapter 6.    

wpdmo_01 WinPAC demo_01: Read/Write float value from file in the PAC.  
FAQ-060 

wpdmo_02 WinPAC demo_02: Read/Write long integer from file in the PAC.  

wpdmo_03 To output at a time interval:  SYSDAT_R, SYSDAT_W, SYSTIM_R, SYSTIM_W (ST+QLD) 

wpdmo_04 WinPAC demo_04: User defined Modbus protocol  (No using "Mbus") 

wpdmo_05 
To do something at some sec later when an event happens. 

(FAQ-017)  
slot 0: I-87055W 

wpdmo_06 Using Message Array - MsgAry_r and MsgAry_w 

wpdmo_07 Convert float value to string, using real_str and rea_str2 

wpdmo_08 PID control, refer to the document. 

wpdmo_09 Store (or backup) Boolean / long integer value to (from) files 

wpdmo_10 Store (or backup) Boolean / long integer value to (from) EEPROM 

wpdmo_11 
Store three values to three files in the \Micro_SD folder per 10 seconds, and change the 

file name per month. 

wpdmo_14 Retain variable by Retain_b, Retain_N, Retain_f, and Retain_t.  (FAQ-074) 

http://www.icpdas.com/en/download/show.php?num=333
http://www.icpdas.com/en/download/show.php?num=1005
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq060.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq017.pdf
https://www.icpdas.com/en/download/show.php?num=2807
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq074.pdf
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Project Name Description I/O Boards (Notes) 

wpdmo_16 
Store three values to three files in the \Micro_SD folder per minute, and change the file 

name per day. 

wpdmo19 
Send UDP String to PC when alarm happens by using variable 

array, Time_Gap is 1 second. 
slot0: I-87055W 

(Section 19.2 of 

ISaGRAF Manual) 

wpdmo19a Send UDP String to PC 3 seconds later, Time_Gap is 250ms. 

wpdmo19b 
Send UDP String to PC 3 seconds later, Time_Gap is 250ms. 

(wpdmo19a is better) 

wpdmo_20 Receive String coming from remote PC or PAC via UDP/IP 

wpdmo_21 Using "com_MRTU" to disable/enable Modbus RTU Slave port. 

wpdmo_22 
PWM I/O demo.   

(Pulse Width Modulation, minimum scale is 2ms for WinPAC) 
slot 0: I-8055W 

wpdmo_23 
Send Time String to COM3: RS-232 every second by using COMOPEN and COMSTR_W.  

(FAQ-059) 

wpdmo_24 Send string to COM3 when alarm 1 to 8 happens.  slot 0: I-87055W 

wpdmo_26 
To move some pulse at x-axis of I-8091W of slot 1 in WP-8x47 

(Chapter 18 of the “ISaGRAF User's Manual” ) 

slot 1: I-8091W 

 

wpdmo_27 Motion x slot 1: I-8091W 

slot 2: I-8090W 

(Chapter 18 of 

ISaGRAF Manual) 

wpdmo_28 Motion x-y 

wpdmo_29 Moving to the Abs. position when CMD is given 

wpdmo_30 
WP-8x47 (10.0.0.102) connect two i8KE8 + I/O,  

one is 10.0.0.108, one is 10.0.0.109.  FAQ-042 

wpdmo_31 WP-8x47 (10.0.0.102) connect one i8Ke8 + I/O (10.0.0.109) 

wpdmo_32 
Set WP-8x47 as TCP/IP Client and connect to other TCP/IP Server 

(1 connection)  slot 0: I-87055W 

(Section 19.3 of 

ISaGRAF Manual) wpdmo_33 
Same as Wpdmo_32 but send message only when event last for 

larger than 3 seconds. 

wpdmo_36 Read Real Val from Modbus RTU device. 
FAQ-047,  075 

wpdmo_37 Write Real Val to Modbus RTU device.  

wpdmo_38 Using Modbus function code 6 to write 16 bits.   FAQ-046,  075 

wpdmo_39 WP-8x47 + I-8172W connecting FRnet I/O modules. FAQ-082 

wpdmo_41 
COM3 connecting 1:M7053D + 2:M7045D (MBRTU format, baud=9600) 

(Chapter 21 of ISaGRAF Manual) 

wpdmo_42 COM3 connecting 1:M-7053D to get D/I counter value  (MBRTU format, baud=9600) 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq059.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq042.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq047.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq075.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq046.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq075.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq082.pdf
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Project Name Description I/O Boards (Notes) 

wpdmo_43 COM3 connecting 1:M7017R + 2:M7024 (MBRTU format, baud=9600) 

wpdmo_44 COM3 connecting 1:M7017RC ,  Current input, +/- 20mA,  4-20mA (Modbus format) 

wpdmo_45 COM3 connecting 1:M-7019R (set as T/C K-type input) (MBRTU format, baud=9600) 

wpdmo_46 COM3 connecting 1:M7080 (MBRTU format, baud=9600) 

wpdmo_48 VB.net 2005 demo - "MBTCP_demo" (FAQ-051) 

wpdmo_50 Non-linear conversion. like give P to find V (P, V relation listed in a file) 

wpdmo_51 Read 10 REAL value from a file,10 rows, each row has 1 REAL value, use str_real 

wpdmo_52 Msg_F.  

wpdmo_53 Msg_N.  

wpdmo_54 
Using msg_f to read 20 REAL values from a file, total 4 rows, each row has 5 REAL 

values.  (FAQ-060) 

wpdmo_55 Using msg_n to read 20 Integers from a file, total 2 rows, each row has 10 Integers. 

wpdmo56 Retain 17 REAL values to a file, total 2 rows, each row has 10 REAL values. 

wpdmo56a Retain 2 Boolean + 17 REAL to a file, 2 rows, each row has 10 REAL values. 

wpdmo56b Retain 25 Integer to a file, 2 rows, each row has 10 integer values. 

wpdmo56c Retain 2 Boo + 25 Integer to a file, 2 rows, each row has 10 integer values.  (FAQ-060) 

wpdmo56d Retain 17 Real + 2 Boo + 10 Integer to 2 files, each row has 10 values. 

wpdmo56e Retain more than 255 Real, 255 Boo, and 255 Integer to 2 files,  up to 1024 values. 

wpdmo_61 Report data automatically to PC via UDP. PAC=10.0.0.103, PC=10.0.0.91 

wpdmo_62 
Send email via Ethernet port.   

(To one receiver without attached file)   FAQ-067, 071,  

072, and 077 
wpdmo_63 Send email to one receiver with one attached file.  

wpdmo64a Time synchronization of many PACs via Ethernet. 

64a: station 1001 ; 64b: station 1002 wpdmo64b 

wpdmo65a 
Record temperature to a file per minute, then send the record file 

by Email per day. slot 2: I-87018z 

FAQ-067, 071,  

072, and 077 wpdmo65b 
Same as wdmo_65a, also add time synchronization and state 

report to PC.  

wpdmo_66 
Record channel 1 to 4 i8017HW’s voltage per 20ms, then send the 

record file by Email 

slot 2: I-8024W 

slot 3: I-8017HW 

 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq051.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq060.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq060.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq067.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq071.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq072.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq077.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq067.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq071.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq072.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq077.pdf
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Project Name Description I/O Boards (Notes) 

wpdmo_70 FRnet application: Port0, FR-2057 (addr.=4), FR-2053 (addr.=8) 

slot 1: I-8172W  

FR-2057 

FR-2053 

wpdmo71a 
Using COM4 to connect a I-7530 and a CANopen device (ID=1, 8DI, 8DO, 4AO, 8AI).  

(FAQ-086)  

wpdmo71b Similar to wdmo_71A, but connecting two I-7530. One is at COM5, one is at COM6 

wpdmo71c 
Using COM4 to connect a I-7530 and a CAN device to get string (or float and integer 

data) 

wpdmo71d Similar to wdmo_71c, but connecting two I-7530. One is at COM5, one is at COM6 

wpdmo71e 
Using COM5 to connect a I-7530 and a CANopen device;  

Using COM6 to connect a I-7530 and a CAN device. 

wpdmo72a New WP-8x47 redundant system with RU-87P4 + I-87K I/O (Without Touch HMI).   

wpdmo72b 
Same as wpdmo72a, but setup COM1 as Modbus RTU Slave port to connect one RS-232 

Touch HMI.   

wpdmo72c New WP-8x47 redundant system with I-8KE8-MTCP I/O (without Touch HMI) 

wpdmo74a To get average value of one REAL value.   
FAQ-099 

wpdmo74b To get average value of one Integer value.   

wpdmo75 Using the I-8088W (8-ch, PWM output) in slot0 slot 0: I-8088W 

wpdmo75b 
Connect the I-87088W (I-7088) (addr.=1, baud=115200) via 

WP-8x47's COM2: RS485 
I-87088W (I-7088) 

wpdmo_76 SMS : use COM4 to connect a GTM-201-RS232 GTM-201-RS232 

wpdmo77a Sending/Receiving UDP bytes by using eth_udp, eth_send( ), and eth_recv( ) 

wpdmo77b Sending/Receiving TCP bytes by using eth_tcp, eth_send( ), and eth_recv( ) 

wpdmo78 
WP-8x47 (COM2: Modbus Master) connect a M-7011 (ID=1, 

baud=9600) to get AI, DI  
M-7011 

wpdmo79a Application1: Modbus RTU Master (Central station) 

FAQ-119 

wpdmo79b Application1: Modbus RTU Slave (local PAC1), set ID to 1 

wpdmo79c Application1: Modbus RTU Slave (local PAC2), set ID to 2 

wpdmo80a Application2: Modbus TCP Master (Central station) 

wpdmo80b 
Application2: Modbus TCP Slave (local PAC1), set ID to 1, 

LAN1=192.168.1.178 ; LAN2=192.168.1.179 

wpdmo80c 
Application2: Modbus TCP Slave (local PAC2), set ID to 1, 

LAN1=192.168.1.180 ; LAN2=192.168.1.181 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq086.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq099.pdf
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq119.pdf
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Project Name Description I/O Boards (Notes) 

wpdmo81 Using Aver_N and Aver_F to get Moving Average (FAQ-120) slot 1: I-8017HW 

wphmi_01 WinPAC Web HMI example 01: Display PAC's date & time (No I/O board) 

wphmi_02 WinPAC Web HMI example 02: DI & DO demo slot 0: I-87055W 

wphmi_03 WinPAC Web HMI example 03: Read/Write Long, float, and Timer value. 

wphmi_04 WinPAC Web HMI example 04: Read/Write PAC's String.  

wphmi_05 WinPAC Web HMI example 05: Multi-Page demo 

05: Menu is on the Left ; 05a: Menu is on the Top 
slot 0: I-87055W 

wphmi05a 

wphmi_06 WinPAC Web HMI example 06: AIO demo 

06: scaling is in ISaGRAF ; 07: scaling is in PC 

slot 2: I-87024W 

slot 3: I-8017HW wphmi_07 

wphmi_08 WinPAC Web HMI example 08: Download PAC's file to PC. 
slot 0: I-87055W 

wphmi_09 WinPAC Web HMI example 09: Display an alarm window on PC.  

wphmi_11 Trend curve demo 
slot 2: I-87024W 

slot 3: I-8017HW 

wphmi_12 
Record channel 1 to 8 of I-8017HW 's voltage every 50ms and 

draw trend curve by M.S. Excel. 
I-8017HW 

wphmi_13 
Record channel 1 to 4 of I-8017HW 's voltage every 10ms and 

draw trend curve by M.S. Excel. 

 

 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq120.pdf
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Restore the ISaGRAF demo programs 

Before restoring the ISaGRAF demo programs, it is recommended creating an "ISaGRAF Project Group" 

to restore these files.  

 

Click the Select project group button and click the New group button, then enter a name. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

To restore the demo programs to the project group, open the "ISaGRAF Project Management" window 

and click "Archive" and "Projects" from the "Tools" menu. 
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In the "Archive Projects" window, click on the "Browse" button to select the location of demo files and 

click OK. (WP-8x47’s demo folder: \isagraf_winpac_demo). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select all files displayed in the "Archive" field and click the "Restore" button to restore all demo 

programs to ISaGRAF Workbench.  

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

 

2. 

 

3. 
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9.3 Frequently Asked Questions 

FAQ: https://www.icpdas.com/en/faq/index.php?kind=280#751 

 

FAQ Table: 

No. English ISaGRAF Ver.3 FAQ 

001 How to get counter value built in I-7000 & I-87K remote I/O modules? 

002 How to search I/O boards and declare variables automatically for I-8xx7? 

003 How to build an HMI screen by using ISaGRAF? 

004 Can I create my own functions inside ISaGRAF? 

006 
Can I use an ISaGRAF PAC (I-8417/8817/8437/8837, I-7188EG/XG) as a Modbus Master PAC to 
gather data from other Modbus devices? 

007 Can I write my own protocol or third-party protocol to apply to ISaGRAF PACs? 

008 What is the limitation of the program size of I-8417/8817/8437/8837, I-7188EG & I-7188XG? 

009 Cannot find I/O boards in the ISaGRAF I/O connection window? 

010 
I Want to email my ISaGRAF program to someone. How can I archive one ISaGRAF project to a 
single file? 

011 How can I implement motion control in I-8417/8817/8437/8837? 

012 
My HMI software wants to access to float values and long word values inside the 
I-8417/8817/8437/8837, 7188EG & 7188XG. How? 

013 
PWM: Can I generate D/O square pulse up to 1KHz with I-8417/8817/8437/8837, 7188EG & 
7188XG? How? 

014 Can I use 8K parallel D/I board to get counter input up to 1KHz? How? 

015 
How to output something at a time interval? For example, turn ON at 09:00 ~ 18:00 from 
Monday to Saturday, while 13:00 ~ 20:00 on Sunday. 

016 How to determine a D/I if it has a bouncing problem? 

017 How to trigger something at some seconds later when one event happens? 

018 
Does the ISaGRAF-256 software have I/O Tags limitation? Why not using the “ISaGRAF-L” Large 
version? 

019 Why my I-8417/8817/8437/8837 or I-7188EG/XG stop running? 

020 How to search a variable name in an ISaGRAF project? 

021 When closing my ISaGRAF window, it holds for a long time. Why? 

023 
How to reduce ISaGRAF code size? How to directly Read/Write ISaGRAF variables by using 
Network address? 

024 How to scale analog input and output of 4 to 20 mA (or 0 to 10 V) to my engineering format? 

025 The fault detection for the PAC 

026 New ISaGRAF retained variable is better than the old one. 

027 How to link to the Modbus ASCII Slave device? 

028 How to use multi-port Modbus Master on ISaGRAF PAC? 
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No. English ISaGRAF Ver.3 FAQ 

029 
How to send/receive a message from ISaGRAF PAC to remote PCs or PACs via Ethernet UDP 
communication? 

030 
Setting special “range” parameter of temperature input board to get clear “Degree Celsius” or 
“Degree Fahrenheit” input value. For example, “1535” means 15.35 degrees. 

031 
Setting a special “ADR_” parameter of the remote I-7000 & I-87K temperature input module to 
get clear “Degree Celsius” or “Degree Fahrenheit” input value. For example, “8754” means 
87.54 degrees. 

034 
How to access to ISaGRAF variables as an array? (A demo program of sending a string to COM2 
or COM3 when alarm 1 to 8 happens) 

037 Compiling error result in different ISaGRAF version? 

038 I-7188EG/XG support remotely downloads via Modem Link 

039 Setting I-7188EG/XG 's COM3 as Modbus RTU Slave port 

040 Using Variable Array 

041 Setting I-8437/I-8837/I-8437-80/I-8837-80 's COM3 as Modbus RTU Slave port 

046 How to connect PC / HMI to a Redundancy system with a single IP address? 

047 How to Write 16-bits to Modbus RTU devices by Modbus function call No. 6? 

049 How to Read or Write Floating-Point Value to Modbus RTU Slave device? 

050 
Setting a special “CODE_” parameter of “MBUS_R” & “MBUS_R1” to get a clear “Degree 
Celsius” or “Degree Fahrenheit” input value of M-7000 temperature module. For example, 
“3012” means 30.12 degrees. 

051 How to connect an ISaGRAF PAC to M-7000 remote I/O? 

052 VB.net 2005 Demo program using Modbus TCP/IP protocol to control ISaGRAF PACs 

055 VB 6.0 Demo program using Modbus TCP/IP protocol to control ISaGRAF PACs 

056 
How to connect I-7018z to get 6 channels of 4 to 20 mA input and 4 channels of 
Thermo-couple temperature input? And also display the value on PC by VB 6.0 program? 

057 How to do a periodic operation on ISaGRAF PACs? 

058 

How to record I-8017H's Ch.1 to Ch.4 voltage input in a user allocated RAM memory in 
ISaGRAF PAC? The sampling time is one record every 0.01 second. The record period is 1 to 10 
minutes. Then PC can download this record and display it as a trend curve diagram by M.S. 
Excel. 

059 
How to record I-8017H's Ch.1 to Ch.4 voltage input in S-256/512 on I-8437-80 or I-8837-80? 
The sampling time is one record every 0.05 second. The record period is 1 to 10 minutes. Then 
PC can download this record and display it as a trend curve diagram. 

060 Some skill to operate RS-232/422/485 serial COM Port by COM functions 

061 How to read/write file data on WinPAC and XPAC? 

062 Linking RS-485 I-7000 & I-87K I/O Modules 

063 How to setup a redundant system with Ethernet I/O? 

065 
Why my RS-485 remote I-7000 and I-87K Output module's host watchdog function doesn't 
work to reset its output channels to safe output value while the RS-485 communication cable 
is broken? 
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No. English ISaGRAF Ver.3 FAQ 

066 
ICP DAS Release Stable and Cost-effective Data Acquisition Auto-Report System. (VC++ 6.0 and 
VB 6.0 and ISaGRAF demo program are available) 

067 
How to process the Integer or Real value coming from the RS-232/RS-485 device? Like the 
device of Bar-Code reader or RS-232 weight meter. 

068 How to send an email with one attached file by iP-8447/8847 or uPAC-7186EG? 

070 Why the I-8xx7 or I-7188EG/XG or uPAC-7186EG or iP-8xx7 always reset? How to fix it? 

071 How to do Time Synchronization and record state of many ISaGRAF PAC? 

072 
Application: Record 10-Ch. temperature value into a file on ISaGRAF PAC every minute. When 
24-hour recording is finished, send this record file by email every day. 

073 
Application: Record Voltage/Current input by ISaGRAF PAC every 20 ms for 1 to 10 minutes. 
Then send this record file by email. 

074 Why the I 7017 or I 87017 s Current Input reading value become double or incorrect? 

075 How to use ISaGRAF New Retain Variable? What is its advantage? 

077 Why my ISaGRAF project cannot connect Modbus Slave device correctly? 

080 
Application sample: Record Voltage/Current input by μPAC-7186EG every second for 1 to 10 
minutes. Then send this record file by email. 

081 
Application: Record 10-Ch. temperature value into a file in μPAC-7186EG every minute. When 
24-hour recording is finished, send this record file by email every day. 

082 How to measure +/-150 VDC in ISaGRAF PACs plus the I-87017W-A5 I/O card? 

083 How to use FRNET fast I/O? 

084 
Why are my I-8x37, I-8x37-80, I-7188EG and uPAC-7186EG 's TCP connections disconnected 
and then recovered about every 20/40 hours? 

086 Cost Effective Redundancy System by uPAC-7186EG or I-8437-80 

087 
The uPAC-7186EG and iP-8447/8847 connecting one or several I-7530 to link many CAN or 
CANopen devices and sensors. 

088 
What does it mean and how to fix it when the 7-segment LED shows error messages of Err00, 
Err02, Err03, Err90 or E.0001 after booting the PAC? 

089 
Function Modifications: The μPAC-7186EG, I-8x37-80, I-8xx7 and I-7188EG/XG with S256/512 
and X607/608 no longer support old retain method, change to use the better new retain 
method to retain variables 

090 Why my μPAC-7186EG unable to renew the driver and ISaGRAF application? 

092 How to use I-7017Z module in ISaGRAF PAC? 

096 Setting μPAC-7186EG’s and I-7188EG/XG 's COM3 or COM2 as Modbus RTU Slave port 

097 
Release Two C-Function-Blocks to Read Max. 24 Words or 384 Bits from Modbus RTU/ASCII 
Devices 

098 
How to modify the PAC’s IP, NET-ID and Modbus RTU Slave port setting of the XP-8xx7-CE6 by 
a USB pen drive (without Mouse and VGA)? 

099 Application: Link Serial COM Port to the Modbus RTU device by COM functions 

100 
How to get an average value of a Real or Integer variable which is sampled every fixed interval 
(or sampled in every PLC scan )? 
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No. English ISaGRAF Ver.3 FAQ 

101 How to use I-8084W (4/8 – Ch. Counter or 8-Ch. frequency)? 

104 
How to read a max of 120 Words (or 60 Long-Integers or 60 REAL value) from Modbus 
RTU/ASCII devices by using 'MBUS_XR' or 'MBUS_XR1' function block? (For ISaGRAF WinCE 
PAC only) 

105 Why my PC running ISaGRAF cannot connect the ISaGRAF PAC correctly? 

107 Program 8-Channel PWM Output Board: I-8088W or I-87088W or I-7088 In The ISaGRAF PAC. 

109 
How to do auto-time-synchronization and measure the local Longitude and Latitude by using 
the GPS-721 or I-87211W GPS I/O module in ISaGRAF PAC? 

111 
How to adjust the system time of some ISaGRAF PACs via Ebus by using ISaGRAF PAC and 
I-87211W? 

112 SMS: Short Message Service 

113 Program the I-8093W (3-axis high-speed Encoder input module) by ISaGRAF. 

114 Linking ISaGRAF PAC to Modbus TCP/IP Slave Devices by Modbus TCP Master Protocol 

115 How to avoid garbled content when printing ISaGRAF PDF documents? 

117 How do I use ISaGRAF SoftLogic and the eLogger HMI with an ISaGRAF WinCE-based PAC? 

119 How to install the ISaGRAF Ver. 3 on Windows Vista or Windows 7? 

120 
How to implement the communication redundancy between the central control station and 
the local stations? 

121 How to calculate the moving average value of a variable by c-functions "Aver_N" or "Aver_F"? 

123 How to install or remove the ISaGRAF development platform properly? 

124 How to move the InduSoft picture faster in the XP-8xx6-CE6? 

125 A Web HMI Example for ISaGRAF Professional XPAC XP-8xx7-CE6-PRO – by FrontPage 

126 The XP-8xx7-CE6 Redundant System (iDCS-8000 I/O ) 

128 
How to use the WP-8847 to connect ET-7018Z and ET-7044D and develop the HMI program by 
InduSoft, VS2008 C#, and VB.NET? 

129 
How to use the ISaGRAF PAC plus I-87113DW - the Master card of the Carlson Strain Gauge 
Inputs? 

130 How to Connect the ICP DAS Power Meter – PM-2133 and PM-2134 by the ISaGRAF PAC? 

132 How to automatically synchronize the time of XP-8xx7-CE6 over a network? 

133 Motion Control - Using I-8094F/8092F/8094 

134 How to send and receive UDP/TCP data? 

135 How to reset the ISaGRAF driver or reset the PAC by software? 

136 
How to program ISaGRAF PAC to support SQL Client to write data to (or read data from) 
Microsoft SQL server? 

138 HART Solution : ISaGRAF PAC plus I-87H17W 

139 
How to program an XP-8xx7-CE6 redundant system (with I-87K8 expansion base or Modbus I/O 
or other I/O)? 

140 How to install/use ISaGRAF 3.55 Demo Version and its limitations 
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No. English ISaGRAF Ver.3 FAQ 

141 
How to communicate between InduSoft local HMI and ISaGRAF PACs via Modbus TCP 
protocol? 

142 iP-8xx7/μPAC-7186EG/I-8xx7/I-8xx7-80 provide the Flash memory write-protect feature 

143 How to protect your ISaGRAF program from used by the unauthorized people? 

144 
How to Make ISaGRAF WinCE PAC to Connect to the Internet and Send Data by GPRS or 3G 
wireless Dial-up? How to get the location by using GPS? 

145 A new function block Mbus12w to write max. 12 words to Modbus salve devices. 

147 How to use ISaGRAF via I-8123W to control the CANopen Slave devices? 

148 How to use the VPD-130 to read the μPAC-7186EG's system date and time via RS-485? 

149 User Guide for I-87017DW, I-87017ZW and I-87019ZW Cards 

151 How to make the ISaGRAF WinCE PAC play a sound? 

152 How to use FTP Client to upload log files to remote FTP Server on PC? 

153 How to control the IR module, IR-210/IR-712, with the ISaGRAF PACs? 

154 
How to use the ISaGRAF PAC to communicate with a faraway Modbus TCP server or an FTP 
server by the 3G or 2G wireless GPRS? 

156 How to use the FRnet AI/AO module with the ISaGRAF PAC? 

157 ISaGRAF PAC connects a DL-100TM485 to measure humidity and temperature values. 

159 How to link to the Temperature and Humidity module, DL-100T485, with the ISaGRAF PAC?  

160 How to use the tGW-700 Series, Modbus TCP to RTU/ASCII gateway, with the ISaGRAF PAC? 

161 Using many Modbus function blocks Mbus_AR and Mbus_AW in a For-loop in the ISaGRAF PAC 

162 How to deliver event data by ISaGRAF PAC? 

163 Why is the Power LED or the L1 LED indicator on the PAC blinking? 

165 How to use the ISaGRAF PAC to control the tM-series and LC-series Modbus I/O Modules? 

166 ISaGRAF WinCE PAC - Schedule Control.  

167 Develop your own c-function and c-function blocks in the ISaGRAF WinCE PAC.  

168 How to write an ISaGRAF program to copy/delete all files in one directory?  

169 How to use the I-87028UW/CW, I-87024UW/CW modules on ISaGRAF PAC?  

171 
How do I use the "Mbus_RW" function block in the ISaGRAF PAC to easily monitor the Modbus 
device?  

172 How to use ISaGRAF functions to read multiple strings from a file?  

173 Why can't I connect to the ET-7000 web page using a web browser?  

174 
How to use the VMware Workstation/Player to create an ISaGRAF (Ver. 3.55) development 
environment?  

175 How to test an Ethernet/Internet connection by using the ISaGRAF PAC?  

 



 

Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         10-1 

Chapter 10 Using C# .net 2008 Program to Access ISaGRAF 

Variables 

Important Notice: 

Please store your application programs and data files in the \Micro_SD. Don't store them in the 

\System_disk. That is because the \System_Disk is using NOR Flash memory. Its size is small and the 

major purpose is for storing OS, ISaGRAF driver, some basic utilities and DLL.  

 

The NOR Flash memory is not good for frequently updating files. If update files frequently in the 

\System_Disk (e.g., update a file every 1 to 5 seconds, then it will be about ten thousand more updates 

in one day), the data or files in the \System_disk may crush or lost for some days or months later. 

 
 

This chapter lists the steps for creating the first demo program by using Visual Studio .NET 2008 
development tool. There are some sample programs in the WP-8x47 demo folder. 
 
WP-8x47 demo folder: ...\isagraf_winpac_demo\CSharp.net_2008_demo\ 

wp_CSharp01: Digital I/O demo with one I-87055W in slot 0 of the WP-8x47. 

wp_CSharp02: Analog I/O demo with one I-87024W in slot 1 and one I-8017HW in slot 2. 

wp_CSharp03: Read / Write ISaGRAF internal integers, timers and real variables. (No I/O) 

 

The name of ISaGRAF demo projects are "wp_vb01.pia", "wp_vb02.pia” and "wp_vb03.pia" in the same 

directory. 

 

 

 

10.1 Create a New Project 

 

1. Start Microsoft Visual Studio .NET 2008 and click File > New Project on the menu bar. 
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2. Check the “Smart Device” on the left, then select the “.NET frame work 2.0” and “Smart Device 

Project”. Then entering a proper project name (e.g., project1) and the last click on “OK”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 2.0”, 

then click on “OK”.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1. 

 

2. 

 

3. 

 

4. 

 

5. 

 

1. 

 

2. 

 

3. 

 

4. 
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10.2 Add Project Reference for an Application  

The “QuickerNet” library contains all modules’ functions. Before you use the “Quicker” keyword in the 

program, you must add the “QuickerNet.dll” into the reference list of your application.   
 

1. Right click on the Project name on the right hand side ,  

then select “Add Reference …”. 
 

2. Select the “mscorlib” in the list box and click the button 

“OK” (“mscorlib” is listed in the Component Name field on 

the .NET page.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

3. Click the “Browse” button and select the “quickernet.dll” from WP-8x47 demo folder: 

\isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp01, then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right-click 
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4. When both “mscorlib” and “QuickerNet.dll” are added that will be displayed in the Solution 

Explorer window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Right-click on the “Form1.cs” and select “View Code” from the pop-up.  

Move cursor to top and insert the “using Quicker;” in the first statements.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Then you can design all required objects and actions inside your C# Forms. 

 

 

 

 

 

 

 

 

 

 

 

Right-click 
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10.3 Compiling an Application Program  

When you have finished writing a program, you can build an application by the following steps.  

 

1. Remember to save at any time for safety. 

 

 

 

 

 

 

 

 

 

2. Compile (Build) the project, and the result is listed in the “Error List” windows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. You can find the execution file in   

 

<Your C# .net Project folder> \bin\Release\ <project_name>.exe 

Copy this execution file to the \System_Disk\ISaGRAF\ path in the WP-8x47 and  run it. 

 

 

Note:  

User may copy the C#.net execution file to other path to run it but there should contain at least 

“QuickerNet.dll”, “Quicker.dll”, and “Mscorlib.dll” three DLL files with it or it cannot run correctly. 

 

For example, the project1.exe can run in the \Micro_SD\ path if “QuickerNet.dll”, “Quicker.dll” and 

“Mscorlib.dll” are in it. These DLL files can be copied from the path “\System_disk\ISaGRAF\” in the PAC. 
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10.4 QuickerNET.DLL  

This section we will focus on the description of the application example of QuickerNET.DLL functions. 

There are some functions that can be used to Read/Write data from/to the ISaGRAF SoftLogic. The 

functions of QuickerNET.DLL can be clarified as two groups as depicted as below:  

 

1. Digital R/W Functions   

2. Analog R/W Functions 

 

 

 

 

 

 

10.4.1 Digital R/W Functions   

  

■ UserSetCoil 

 
Description:  

This function is to set the value to a Boolean variable by Modbus network address. 

 

Syntax:  

 

UserShare.UserSetCoil(ushort iUserAddress, byte iStatus) 

 

Parameter:  

iUserAddress: Specify the Modbus Network Address of Variable (1 to 8191) 

iStatus: Set the status. For instance, iStatus = 1 for True, iStatus = 0 for False 

 

Return Value:  

None  

 

Example:  

// Set the output variable of Modbus Network Address “1” to True.  

UserShare.UserSetCoil(Convert.ToUInt16(1), 1);  

 

Demo program:  

WP-8x47 demo folder: \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp01 
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■ UserGetCoil 

 
Description:  

This function is to get the value from a Boolean variable by Modbus network address. 

 
Syntax:  

 

UserShare.UserGetCoil(ushort iUserAddress, out byte iStatus) 

 

Parameter:  

iUserAddress: Specify the Modbus Network Address of Variable (1 to 8191) 

iStatus: Get the variable status, iStatus = 1 for True, iStatus = 0 for False 

 

Return Value:  

None  

 

Example:  

// Get the variable status of Network Address “1”.  

byte iStatus;  

UserShare.UserGetCoil (Convert.ToUInt16(1), out iStatus);  

 

Demo program:  

WP-8x47 demo folder: \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp01 
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10.4.2 Analog R/W Functions 

 

UserSetReg_short ■ UserSetReg_long ■ UserSetReg_float 

 
Description:  

These functions are to set 16-bit short integer, 32-bit long integer & 32-bit float value to the specified 

Modbus network address. 

 

Syntax:  

UserShare.UserSetReg_Short(ushort iUserAddress, out int iStatus) 

UserShare.UserSetReg_Long(ushort iUserAddress, out int iStatus) 

UserShare.UserSetReg_Float(ushort iUserAddress, out float iStatus) 

 

Parameter:  

iUserAddress: Specify the Network Address of Variable (1 to 8191) 

iStatus: Set the short or long integer or float value. 

 

Example:  

// Set a long value “1234567” to the variable of Modbus Network Address “1”.  

int temp1=1234567; 

UserShare.UserSetReg_long(Convert.ToUInt16(1), out temp );    

 

// Set a short value “-1234” to the variable of Modbus Network Address “3”.  

int temp2= -1234; 

UserShare.UserSetReg_short(Convert.ToUInt16(3), out temp2 );    

 

// Set a float value “2.174” to the variable of Modbus Network Address “4”.  

float temp3=2.174; 

UserShare.UserSetReg_float(Convert.ToUInt16(4), out temp3 );    

 

Demo program:  

WP-8x47 demo folder:   

1. \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp02 for R/W analog I/O. 

2. \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp03 for R/W internal Boolean, long integer, 

Timer and Real (floating-point) values. 

 

Note:  

In the ISaGRAF project, long integer, timer, or real variable must use 2 network address numbers. 

Refer to section 4.2 of ISaGRAF User Manual: 

http://www.icpdas.com/en/download/show.php?num=333  

 

 

 

http://www.icpdas.com/en/download/show.php?num=333
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■ UserGetReg_short ■ UserGetReg_long ■ UserGetReg_float 

 

Description:  

These functions are to get 16-bit short integer, 32-bit long integer & 32-bit float value from the specified 

Modbus network address. 

 

Syntax:  

UserShare.UserGetReg_Short (ushort iUserAddress, out int iStatus) 

UserShare.UserGetReg_Long (ushort iUserAddress, out int iStatus) 

UserShare.UserGetReg_Float (ushort iUserAddress, out float iStatus) 

 

Parameter:  

iUserAddress: Specify the Network Address of Variable (1 to 8191) 

iStatus: Get the short or long integer or float value.  

  

Example:  

float float_val 

short short_val 

int long_val 

  

// Get float value of the variable of Modbus Network Address “7”.  

UserShare.UserGetReg_float (Convert.ToUInt16(7), out float_val);  

 

// Get long value of the variable of Modbus Network Address “9”.  

UserShare.UserGetReg_long (Convert.ToUInt16(9), out long_val); 

 

// Get short value of the variable of Modbus Network Address “11”.  

UserShare.UserGetReg_short (Convert.ToUInt16(11), out short_val); 

 

Demo program:  

WP-8x47 demo folder:   

1. \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp02 for R/W analog I/O. 

2. \isagraf_winpac_demo\CSharp.net_2008_demo\wp_CSharp03 for R/W internal Boolean, long integer, 

Timer and Real (floating-point) values. 

 

Note:  

In the ISaGRAF project, long integer, timer, or real variable must use 2 network address numbers. 

Refer to section 4.2 of “ISaGRAF User Manual: 

http://www.icpdas.com/en/download/show.php?num=333  

 

 

http://www.icpdas.com/en/download/show.php?num=333
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Chapter 11 More Useful Features  

This chapter will introduce gradually added and some useful features in ISaGRAF WinCE-based PAC. 

Users can visit the ISaGRAF FAQ to understand these usages.  

 

 

11.1 FAQ-167: Develop your Own C-function and C-function Blocks in the 

ISaGRAF WinCE PAC 

The FAQ-167 provides demo programs to guide users to develop their own C-function and C-function 

Block. More at: https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-167  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq167.pdf
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11.2 FAQ-166: ISaGRAF WinCE PAC - Schedule Control 

 The ISaGRAF WinCE-based PACs support Schedule Control. Users just need a few simple steps to 

configure the date events, such as normal days, weekend, special holidays, make-up workdays and 

four seasons to meet the complex scheduling control needs. 

 One ISaGRAF PAC can control many Schedules for maximum 10 control devices (Target). Each 

control device (Target) can control one Boolean, one Integer and one Real variable (total 3 

variables). 

 More at:  https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-166 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq166.pdf
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Appendix A Hardware System & Setting 

 

A.1 Applying Correct Power Supply  

Please apply a regular power supply between +10V to +30V (> 25W or higher is better) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Selection Guide:  

Power supply:  

http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply 

 DP-660:  24V/2.5A, 5V/0.5A power supply (DIN-Rail mounting) 

 DP-1200: 24V/5A power supply 
 

Industrial Ethernet switch: 

http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html 

 NS-205: 10/100M, 5 ports 

 NS-208: 10/100M, 8 ports 

 

http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Eth

ernet__Switch#787  

 RS-405: 10/100M, 5 ports (Ring Switch) 

 RS-408: 10/100M, 8 ports (Ring Switch) 

 

 

http://www.icpdas.com/en/product/guide+Accessories+Power__Supplies+Power__Supply
http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
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A.2 Modify the NET-ID & Modbus RTU Port Setting  

Users may set the Net-ID (Slave Number) for WP-8x47 in a range of 1 to 255. 

 

By default, Modbus RTU Slave port is “None” when shipped out. Users may set it to others depends on 

its application (also refer to Appendix G & E for more Modbus RTU ports). 

 

Then reboot the WP-8x47 once after the modification to make the new setting work. 
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A.3 Setting the IP Address for the WP-8x47  

Run [Start] > [Setting] > [Control Panel] on the WinPAC, then double-click on “Network and Dial-up 

Connections”. Then click on “LAN1” or “LAN2” to set the IP address and Subnet Mask for WinPAC.   

 

(Only set as fixed IP for ISaGRAF application, No DHCP.) 

 

 

 

 

 

 

 

 

 

 

 

 

Next, run [Start] > [Programs] > [WinPAC Utility], click on “Save and Reboot” to store the setting. 
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A.4 Connecting the PC to the WP-8x47 Ethernet Port 

Before downloading an ISaGRAF application to the PAC using the Ethernet port, you must first setup the 

Ethernet port to properly communicate with the PC. 
 

On the WP-8x47:  

Set IP, Mask and Gateway addresses. 

Refer to former section – “A.3:  Setting The IP Address for The WP-8x47” 
 

On your PC:  

Open an ISaGRAF project (e.g., Test) that you want to download to the WP-8x47, then select the "Link 

Setup" button. 

 

 

 

 

 

 

 
 

 

In the "PC-PLC Link Parameters" window, set the "Ethernet" as the communication port and click the 

"Setup" button. 

 

 

 

 

 

 

 
 

 
 

 

In the "Ethernet Link Parameters" window, enter the IP address of WP-8x47 and set the "Port Number" 

to "502". 
 

 

 

 

 

 

 

 

 

Once you have completed the setting, click the "OK" button. Now, the PC can communicate with the 

WP-8x47 through the Ethernet port. 
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A.5 Multi-Clients Connections and Pin Assignment of COM1, COM2, COM3 

and COM4  

Two Ethernet ports of WP-8x47 support Modbus TCP/IP Slave protocol to connect to ISaGRAF or PC/HMI. 

Both LAN1 and LAN2 support a maximum of 32 connections. The TCP port number is fixed 502. 

 

When using one Ethernet port to connect all PC/HMI, up to 32 PC/HMI can be connected. When using 

two Ethernet port to connect all PC/HMI, up to 16 PC/HMI can be connected. Also, using PAC’s COM1 

(RS-232) or one of COM2 (RS-485)/COM3 (RS-232/485) or COM4 (RS-232) to connect other PC/HMI. 

(Refer to Appendix G & E - Modbus RTU Slave) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Industrial Ethernet switch:  

http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html 

NS-205: 10/100M, 5 ports 

NS-208: 10/100M, 8 ports 

 

http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Eth

ernet__Switch#787  

RS-405: 10/100M, 5 ports (Ring Switch) 

RS-408: 10/100M, 8 ports (Ring Switch) 

 

 

 

 

 

 

 

 

http://www.icpdas.com/root/product/solutions/industrial_ethernet_switch/switch_selection.html
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
http://www.icpdas.com/en/product/guide+Industrial__Communication+Ethernet__Communication+Ethernet__Switch#787
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Pin Assignment: 

COM1, COM2, COM3 and COM4: 

 

WP-8447/8847 

COM1: RS-232 COM2: RS-485 COM3: RS-232/485 COM4: RS-232 

 

 

 
 

  

 

 

WP-8147 

COM1: RS-232 COM2: RS-485 
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A.6 Connecting PC to the COM Port of the WP-8x47  

The default setting of Modbus RTU Slave port is “None”. User may change it to “COM2: RS-485” or 

“COM3: RS-232/485” or “None”. Refer to “A.2: Modify the NET-ID & Modbus RTU port setting” and 

Appendix G, E for more details about Modbus RTU ports. By default, the communication parameter is 

“19200,8,N,1” 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

When connecting PC to WinPAC COM2 or COM3 's RS-485, a I-7520 (RS-232/485 converter) is necessary.  

 

 

 

 

 

 

 

 

 
 

For the ISaGRAF Workbench RS-232 communications to operate properly, only the RXD, TXD, and the 

GND signals are used.  If your PC is running a hardware device or software program that uses the CTS 

and DSR signals, you will need to wire the RTS-CTS and DTR-DSR signals together. 

 

 

 

 

 

 

 

 

 

 

 

WinPAC (RS-232) 

COM3: RS-232/485 

 
 

WinPAC 

COM2: RS-485 

 
 

COM2 

PC 

9-Pin D-Sub: RS-232 

 

 

RxD 2 

TxD 3 

GND 5 

 

 

 

PC 

9-Pin D-Sub: RS-232 

 

2 RxD 

3 TxD  

5 GND  

 

 

I-7520/7520R 

RS-232 to RS-485 
Converter 

D+ 

D- 

 

WinPAC (RS-485) 

COM2: RS-485 
COM3: RS-232/485 

D+ 

D- 

 

WinPAC (RS-232) 

COM1: RS-232 
COM3: RS-232/485 

RxD 2 

TxD 3 

GND 5 

 

WinPAC 

COM4: RS-232 

RxD 2 

TxD 3 

GND 5 

 

PC/HMI 

9-Pin D-Sub  

RxD 2 

TxD 3 

GND 5 

DTR 4 

DSR 6 

RTS 7 

CTS 8 

 

PC/HMI 

9-Pin D-Sub  

RxD 2 

TxD 3 

GND 5 

DTR 4 

DSR 6 

RTS 7 

CTS 8 
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A.7 Deleting the ISaGRAF Project from the WP-8x47 

For some reasons, user may delete the ISaGRAF program in the WP-8x47 PAC. 

 

Click on “Setting” tab and click the “Delete” button to delete the ISaGRAF project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If some software damage happens causing the WinCE software hanging, using this way to delete 

WP-8x47's ISaGRAF program. 

 

1. Turn the rotary switch to the position 1 (Safe mode) on the front panel of the PAC and reboot. 

2. The PAC will be powered on in safe mode. There will be a pop-up window says “... reboot right 

now ...”, answer “No”.  

3. Double-click the “My Device” icon on the WinCE desktop. Go to the “\System_Disk\isagraf\” directory 

and delete the “ISA11”. “ISA11” is the ISaGRAF current running application. If there is no “ISA11” in 

the \System_Disk\ isagraf\ directory, go to Explorer > View > Options to modify the setting. 

4. Turn the rotary switch to the position 0 (Normal mode) and reboot again. 

 

When the connection between ISaGRAF and PAC is established, the ISaGRAF window will display “No 

Application”. Refer to Section 4.3 for more details. 
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A.8 Linking I-7000 and I-87K Modules for Remote I/O 

The WP-8x47 PAC system can use one of its COM2 or COM3 's RS-485 signal to link to ICP DAS's "I-7000" 

and “I-87K” remote I/O modules.  This configuration can be very useful in applications that require 

distributed remote I/O throughout the system. 

 

You can link up to 255 I-7000 or I-87K series remote I/O modules to one WP-8x47 PAC system (It is 

better no more than 40 pcs. of I-7000 or I-87K).  Each of I-7000 and I-87K module must be set a unique 

address, and be set to the same baud rate as the WP-8x47. 

 

Refer to Chapter 6 of ISaGRAF User Manual - "Linking to I-7000 and I-87K Modules" for more details on 

setting up and programming an I-7000 / I-87K remote module. 
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A.9 Linking to an HMI Interface Device 

One of the COM2 (RS-485) or COM3 (RS-232 or RS-485) (or max. four of the COM1, 4 and 5 to 8, refer to 

Appendix G & E) ports of the WP-8x47 can be used to interface with additional Human Machine 

Interface (HMI) devices such as touch displays. 

 

Refer to section A.2 to choose Modbus RTU Slave por. ICP DAS provides a full line of touch screen 

displays, such as the "Touch" series screens.  The models in the product line include the Touch 506, and 

Touch 510 HMI or other Touch 8000 series products. 

 

For more information, refer to:  

1. ISaGRAF User’s Manual. It is listed in Section 4.4 

http://www.icpdas.com/en/download/show.php?num=333    

2. Touch Panel Monitor User Manual  

http://www.icpdas.com/en/download/show.php?num=432   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  
Touch 500 series products have been phased out, visit the website for new information about 
products.  
 

Touch Monitor:  

http://www.icpdas.com/en/product/guide+Panel__Products+Display+Touch__Monitor  

 

 

 

 

 

http://www.icpdas.com/en/download/show.php?num=333
http://www.icpdas.com/en/download/show.php?num=432
http://www.icpdas.com/en/product/guide+Panel__Products+Display+Touch__Monitor


 

                Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         Ap-11  

A.10 Linking to Other Modbus Devices 

The COM2 (RS-485) or COM3 (RS-232/485) (or COM1, 4 and COM5 to 14, refer to Appendix E) supports 

Modbus Master protocol. Refer to Chapter 8 of ISaGRAF User Manual for more information. 

 

 

RS-232: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RS-485: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Modbus Device WP-8xx7 

RS-232 

RXD  

TXD  

GND  

CTS  

RTS  

COM1, 3 

TXD 2 

RXD 3 

GND 5 

Modbus Device WP-8xx7 Modbus Device 

RS-485 

  485 +  

  485 -  

COM2 or COM3 

       D + 

       D - 

 

RS-485 

  485 +  

  485 -  
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A.11 Control the LED Indicator 

WP-8x47 has one programmable LED indicator (RUN) on the panel. In the ISaGRAF, you can use 

“show3led” function in the “I/O Connection” window to control the LED indicator. 

 

1. Click “I/O Connection” to open the window. 

 

 

 

 

 

 

 

 

2. In the “I/O Connection” window, double-click on a slot number larger than (or equals) “9” and select 

“show3led” then click “Save”.  

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Important Notice:   

Slot 1 to 8 are reserved for I/O expansion boards. User can only use the slot 9 or after to set others 

I/O board. 
 

3. Refer to Section 4.2, 4.3 to compile the program and then download to the PAC. 

 

4. After downloading, open the “I/O 

Connection” window.  

 

Change the status of I/O (FALSE/ 

TRUE) then view the change of the 

LED indicator on the front panel of 

the PAC. 

 

 

LED (RUN) 

1. 

2. 

3. 
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Appendix B Upgrade ISaGRAF WinPAC Driver 

Note: 

If you have purchased WP-8x47, the ISaGRAF driver is already installed with license when shipping out. 

It’s necessary to install the driver. However, if a newer version is needed, you may follow the steps to 

upgrade the driver. 

 

Visit the website to download the latest version of ISaGRAF driver.       

https://www.icpdas.com/en/download/show.php?num=368 

 

1. Open the ISaGRAF Driver window and click the “End Driver” button to stop running. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Set up WinPAC’s IP address, Mask address, FTP directory, and the Auto-execute function. 

 

A. Create a folder named “isagraf” in the “\System_Disk” folder on the WinPAC. That is 

\System_Disk\isagraf\. 
 

B. Run “Start” – “Setting” – “Control Panel” on the WinPAC and double-click on “Network and 

Dial-up Connections”. Then click on “LAN1” or “LAN2” to set both the IP address and subnet 

mask address. 

 

(Only using the fixed IP for ISaGRAF application, No DHCP) 
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C. Run WinPAC Utility on PAC desktop. On the FTP Setting page, set all three FTP options as 

“Enable”, set the FTP Directory to “\” (root), and click the “Setting” button.  

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

D. On the Auto Execution page, click the “Browse” button to select the file path or type 

“\System_Disk\isagraf\isaWinPAC.exe” and click the “Setting” button. 
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E. After completing the setting, it must to reboot the PAC by clicking File and Save and Reboot.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. After the WinPAC is powered on, stop running the ISaGRAF driver again.  
 

Note: If the ISaGRAF driver is running, it cannot be updated even the user has done the procedure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Next, it needs to download the WP-8x47 driver from PC to WinPAC directory (i.e., “\System_Disk\ 

isagraf\”). The following files are included in the driver version 1.16 and files may be different in 

different version. 
 

isaWinPAC.exe,  rs_wphmi.exe 

mscorlib.dll,  QuickerNet.dll,  Quicker.dll,  login.dll,  main.dll,  whmi_filter.dll 

isaWinPAC.lnk,  isa_el.dll  and sharedmemory.dll 

 

When using WP-8xx1/8xx9, the WinPAC without installing ISaGRAF), the user needs to download the 

“license.bin” file. 

 



 

                Getting Started: WP-8147/8447/8847, Oct. 2020, V2.0         Ap-16  

These files can be downloaded by using FTP: 

 

Open the Internet browser and then type in ftp://<IP address>, for example, ftp://192.168.1.178, and 

copy-and-paste the WP-8x47 driver to the \System_Disk\isagraf\. Then, reboot the WinPAC. 

 

After the PAC is powered on, the new ISaGRAF driver is running automatically. Open the ISaGRAF Driver 

window to see if the version is correct. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ftp://192.168.1.178/
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Appendix C Dimension 

Unit: mm 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

WP-8147 
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WP-8447 
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WP-8847 
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Appendix D How to Enable/Disable WP-8x47’s LAN2 

Important Notice:   

1. Recommend to use Industrial Ethernet Switch, e.g., NS-205/208 or RS-405/408 (Ring Switch). 

2. For ISaGRAF applications, set a fixed IP to LAN1 or LAN2 when it is enabled.  
 

 

By default, the LAN2 port of WP-8x47 is disabled. Enable the LAN2 port before using it.  
 

Click [Start] > [Setting] > [Control Panel] on the PAC and double-click the “Network and Dual-up 

Connections” icon, then right-click on LAN2 and set it as Enable (or Disable). 

 

Run [Start] > [Programs] > [WinPAC Utility], click “Save and Reboot” to save the setting. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For ISaGRAF applications such as Ebus or redundant system, the LAN2 port of WP-8x47 must be used. 

Also, the LAN2 can be used for sending message via UDP or TCP protocol. 

 

Refer to the ISaGRAF User Manual for more information.  

Section 7.5: Programming the Ebus 

Section 19.2: Delivering Message via UDP 

Section 19.3: To Send/ Receive/ Auto-Report data via TCP/IP 

Section 20.2: WP-8xx7 Redundant System  

 

 

 

 

 

 

 

Right-click 
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Appendix E Using RS-232/485/422 Expansion Modules 

The WinPAC can expand 16 more COM ports in its slot 0 to 7 by using following modules. 

 
I-8112iW: 2-channel isolated RS-232 

I-8114iW: 4-channel isolated RS-232 

I-8114W: 4-channel non-isolated RS-232 

I-8142iW: 2-channel isolated RS-422/RS-485 

I-8144iW: 4-channel isolated RS-422/RS-485 

 

Using “WinPAC Utility” (since version 2.0.0.6) to configure these modules before using them. Plug 

modules into slot 0 to 7 on the WinPAC. (It is better to be in slot 0 to 3) 

 

1. Run [WinPAC Utility] and click the [Multi-serial port wizard] tab. 

2. For ISaGRAF application, make sure that “Use MSA/MSBx” is selected. 

3. Click on “Slot scan”. The current found multi-serial port modules will be displayed on the left.  

The original COM port setting is displayed on the right.  

4. Click “Set” to display the current found modules on the right. 

5. Click [File] > [Save and Reboot] to save the setting and reboot the WinPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. 

 

1. 

 

2. 

 

3. 

 

4. 
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After the configuration succeeds, the COM port No. for the expansion board is COM5 to COM20 in the 

ISaGRAF definition. 
 

The relation between WinPAC's COM setting and the ISaGRAF definition is as the following. 
 

WinPAC ISaGRAF WinPAC ISaGRAF 

MSA1 COM5 MSB1 COM13 

MSA2 COM6 MSB2 COM14 

MSA3 COM7 MSB3 COM15 

MSA4 COM8 MSB4 COM16 

MSA5 COM9 MSB5 COM17 

MSA6 COM10 MSB6 COM18 

MSA7 COM11 MSB7 COM19 

MSA8 COM12 MSB8 COM20 

 

Note: 

1. Refer to Section 8.4 of the ISaGRAF user manual for more about multi-ports Modbus Master. 

WP-8x47 support Modbus RTU/ASCII Master ports in ten of the COM1 to COM14. 

2. Refer to Appendix A.4 of the ISaGRAF user manual for more details on using COM_OPEN, 

COM_READ, … functions to read/write COM ports. 

3.  Refer to Appendix G of this manual for more details on setting up Modbus RTU Slave ports. 
 

 

Pin assignment: 

I-8112iW: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For example, Slot 0:  I-8142iW   

  Slot 1:  I-8144iW 
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I-8114W / I-8114iW: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I-8142iW / I-8144iW: 

RS-485: (D+, D-)   ;    RS-422: (TxD+, TxD-, RxD+, RxD-) 
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Appendix F Slow Down ISaGRAF Driver’s Speed 

The reason to slow down the speed of ISaGRAF driver is when you running some other HMI program 

(For example, InduSoft, or VB.net program) with ISaGRAF at the same time. There is only one CPU, all 

programs running in WinPAC must share execution time of the same CPU. If you feel the HMI program 

behavior is not so smooth, or slow, you may use ISaGRAF “PLC_Mode( )” function to slow down the 

speed of the ISaGRAF driver. 

 

PLC_Mode 

 

Description: 

Function Change the ISaGRAF driver speed. 

 

Argument: 

MODE_  integer Can be 0, 1, 2, or 3 
 

0: Fast Mode, Default setting, the minimum PLC scan time is about 2 to 3ms 

1: Slow Mode, the minimum PLC scan time is about 6 to 7ms 

2: Slower Mode, the minimum PLC scan time is about 9 to 11ms 

3 or other value: Slowest Mode, the minimum PLC scan time is about 19 to 21ms 

 

Return: 

Q_ boolean always return True. 

 

Note: 

1. The system default setting is "Fast Mode". 

2. User may call "PLC_mode( )" function at the first PLC scan to change the PLC speed. 

3. The reason to slow down the PLC speed is to improve system performance while running both HMI 

program and ISaGRAF driver at the same time. For example, both InduSoft and ISaGRAF are running 

in the same WinPAC. 

 

Example:  

  (* TMP is declared as Boolean internal variable *) 

  (* INIT is declared as Boolean internal variable and init at TRUE *) 

  if  INIT  then 

    INIT  :=  False ;   (* Only do it once in the 1st PLC scan *) 

    TMP  :=  PLC_mode(2) ;   (* Set PLC speed to 2:slower mode *) 

  end_if ; 
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Appendix G Setup More Modbus RTU Salve Ports 

WP-8x47 support up to five Modbus RTU Slave ports, i.e., one of the COM2 or COM3 and in four of the 

COM1 to COM8. Refer to Appendix E for more details on using multi-port modules in slot 0 to 3 to add 

COM5 to COM8. 
 

Note:  

There is no COM3 and COM4 on WP-8147. (WP-8447/8847 have COM3 and COM4) 
 

1. The first Modbus RTU Slave port can be one of the COM2 or COM3 which can be set on the PAC 
desktop by using mouse (refer to the Appendix A.2). 

2. The user may enable 2nd, 3rd, 4th or 5th Modbus RTU Slave port in COM1 to COM8.  
(No support other COM port number) 

3. Before using this function, make sure that the above ports do exist and well configured. Refer to the 
Appendix E for more information. 

4. The user can use ISaGRAF to debug or set values via the 2nd, 3rd, 4th or 5th enabled Modbus RTU 
Slave port on the PAC, but cannot stop, download, or update the ISaGRAF program. 
 

However, the user can debug, set value, stop, download, or update the ISaGRAF program via an 
Ethernet port or the first enabled Modbus RTU Slave port on the PAC.  

 

How to setup? 
Set the “Rtu_slav” function in the ISaGRAF IO connection window. Re-compile the project and download 

it to the WinPAC via Ethernet (or the first enabled Modbus RTU port).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RTU_Slave_Port2 to 5: Specify which COM port is enabled (1 to 8), 

0 means not enable it. Baud rate setting can be 600, 1200, 2400, 

4800, 9600, 19200, 38400, 57600, 115200. 

4-ch Boolean inputs: Display whether the specific port is enabled 

or not. True: Enabled.  False: disabled. 

1. 

 

2. 

 

3. 

 

4. 
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Appendix H Compiling Error Result in Different ISaGRAF Version 

Since 2003, all the ISaGRAF example programs provided on the website are written in ISaGRAF 

workbench version of 3.46. If your ISaGRAF workbench is version of 3.51 or newer version, it may 

display error message when you re-compile these example programs.  

 

To erase this kind of error in different ISaGRAF workbench version, run “Make” – “Touch” once and 

re-compile this example project. 

 

The “Make” – “Touch” command will reset all files that have been successfully compiled to become “Not 

compiled yet”.  

 

 

 

 

 

 

 

 

 

 

 

Then the “Make” – “Make application” command will re-compile all of them. 
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Appendix I Using RS-232 Serial/USB Touch Monitor 

There are three types of RS-232 Serial or USB Touch monitor supported by the WP-8000 series. 

 

 “penmount_serial_touch”, “penmount_usb_touch”, or penmount-compatible Touch monitor. 

 “elo_serial_touch”, “elo_usb_touch”, or elo-compatible Touch monitor. 

 “egalax_serial_touch”, “egalax_usb_touch”, or egalax-compatible Touch monitor. 

 

 

I.1 Touch Monitor Drivers and Notice for installing 

Touch monitor drivers for the WP-8000 series are placed in the PAC folder at “\System_Disk\ 

external_device_driver\”.  This folder includes the following drivers, and you must select the correct 

one to execute!  

 

The file name with the word “_vyyyymmdd” stands for the version number and the updated date. 

 

 

 

 

 

 

 

 

 

 

Notice: 

1. To avoid hardware conflicts, do not install both USB and RS-232 drivers. 

2. If the wrong driver has been installed, perform the uninstall command and reinstall it.  

Refer to Appendix I.4 to uninstall the driver. 

3. After the touch monitor driver installed, if the screen does not display properly (e.g., too large, too 

small, or moire, etc.). Refer to Appendix I.5 to adjust the WinPAC display frequency. 

 

The content in Appendix I, taking the "TPM-4100" touch monitor as an example: 

10.4" 800 x 600 Aluminum Resistive Touch Panel with RS-232 or USB, and Power Supply.  

http://www.icpdas.com/root/product/solutions/hmi_touch_monitor/touch_monitor/tpm-4100.html 

 

Also, visit the TPM-4100 download center to download the driver (.cab) 

(http://www.icpdas.com/en/download/index.php?model=TPM-4100) and copy the file to the PAC folder 

at “\System_Disk\external_device_driver\” by FTP.   

 

 

 

http://www.icpdas.com/root/product/solutions/hmi_touch_monitor/touch_monitor/tpm-4100.html
http://www.icpdas.com/en/download/index.php?model=TPM-4100
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I.2 Using the USB Touch Monitor 

 

4. Connect each other with the USB port of the Touch monitor and 

PAC, and then start the PAC. The WP-8x47 only has 1 USB that can 

be used alternately when setting up a driver for the touch monitor. 

Or, set up remotely with VCEP. 

 

5. Install the USB Touch Driver:  

Double-click the correct USB touch driver in the PAC folder “\System_Disk\ external_device_driver\”.  

In this example, the TPM-4100 driver is “PenMount_USB_TOUCH_Vyyyymmdd.CAB”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Screen Calibration: Click [Start] > [Programs] > [USB_TOUCH] > [PenMount] > [Calibration] to 

perform calibration by tapping the pointers that appear on the screen in sequence. Next, as in Step 2, 

perform “Save and Reboot” in the WinPAC Utility. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_utility.htm
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I.3 Using the RS-232 Serial Touch Monitor 

 

1. Using a RS-232 cable to connect the touch monitor with COM4 

of WP-8x47 (refer to Appendix A.5 for the COM4 pin assignment) 

and install a USB mouse on the WP-8x47 for configuring the 

touch monitor driver. Then, start the PAC. 

 

2. Install the Serial Touch Driver:  

Double-click the correct serial touch driver in the PAC folder at \System_Disk\external_device_driver\. 

In this example, the TPM-4100 driver is “PenMount_Serial_TOUCH_Vyyyymmdd(PM6000R).CAB”.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

3. Screen Calibration: Click [Start] > [Programs] > [Serial_TOUCH] > [PenMount] > [Calibration] and tap 

the pointers that appear on the screen in sequence. Next, as in Step 2, perform “Save and Reboot” in 

the WinPAC Utility. 
 

4. Set COM Port: Click [Start] > [Programs] > [Serial_TOUCH] > [PenMount] > [SetCOM] and set COM 

Port as 4 in this example. Then perform “Save and Reboot” in the WinPAC Utility. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click “OK” to install. 

Double-click “WinPAC Utility” on the PAC 

desktop, and click “File” > “Save and Reboot” 

to save settings and reboot the PAC. 

1. 

2. 

3. 
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I.4 Uninstalling the Touch Monitor Driver 

Users may install the wrong touch monitor driver or need to replace a new monitor, uninstall the driver 

before installing a new touch monitor driver. 

 

1. Start Menu: [Start] > [Programs] > [USB_TOUCH or Serial_TOUCH] > [PenMount] > [Uninstall]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Uninstall: Click “Yes” in the pop-up message box to uninstall the touch monitor driver. 

 

 

 

 

 

 

 

 

3. Reboot the WinPAC:  

After completing the uninstall process, click “Yes” in the pop-up message box to reboot the PAC.  

 

 

 

 

 

 

 

 
 
 
 

( USB_TOUCH ) 

( Serial_TOUCH ) 
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I.5 Adjust the WinPAC Display Frequency 

The default display settings of the WinPAC may not support all kinds of the monitor. Refer to this 

Appendix to adjust the display to solve the following problems:  

1. Moire. 

2. No display. 

3. The screen cannot be displayed properly. (bigger or smaller) 
 

The WinPAC supports the function to adjust the display frequency since the following versions: 

PAC Platform OS Version WinPAC Utility Version 

WP-8x47 V1.6.1.1  and later V2.0.2.7 and later 
 

Note:  Some of the frequency may cause the monitor fails to display. Before adjusting the frequency, 

adding the VCEP path on the “Auto Execution” page in the WinPAC-Utility so that the user can 

remotely control the WinPAC by using a PC. (Refer to WinCE5.0 PAC FAQ - w2-001)      

 

The user can push the auto adjust button on the monitor. If the auto adjust cannot solve the problems, 

you can change the display frequency on the WinPAC. 
 

1. Execute the WinPAC_utility on the PAC desktop and click the “System Settings” tab. 

2. Choose the frequency in the Frequency field and click the Setting button. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click [File] > [Save and reboot] to save and reboot the WinPAC.  

 
If the new frequency cannot solve the problem, repeat steps 1 to 3 

to set the correct frequency. 

 

 

 

 

 

https://www.icpdas.com/en/faq/index.php?type=&model=&fkw=vcep#899
http://www.icpdas.com/web/product/download/pac/wince/document/faq/ce5/how_to_use_vcep_to_remotely_control_wince_pac_en.pdf
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Appendix J  Why my PC Running ISaGRAF cannot Connect the 

ISaGRAF PAC Correctly? 

The document also can be downloaded on ISaGRAF FAQ page: 

https://www.icpdas.com/en/faq/index.php?kind=280#751 > FAQ-104. 

 

When using the ISaGRAF Debug function on PC to connect to the ISaGRAF PAC, sometimes it displays a 

pop-up message box says “Can not link ...” or “Can not download” or “Can not find BMP ...” or ...  
 

To solve this problem, follow these steps: 
 

1. Close all ISaGRAF windows and press the Delete key while holding the Control and Alt keys to open 

the Task Manager.  

2. On the Processes page, stop the process which is with empty memory. Then run PC/ISaGRAF again 

to connect to the PAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

3. If the problem is still there and you are using Ethernet to connect the PAC, check if your PC and PAC 

are set in the same IP domain. For example, PC with (IP/Mask) = (192.168.1.2/255.255.255.0) cannot 

connect to PAC = (192.168.3.5, 255.255.255.0). However, it can connect the PAC = (192.168.1.5, 

255.255.255.0) well. 
 

4. If the problem is still there and you are using RS-232 to connect the PAC, check if your RS-232 cable 

is correct and check if you are setting the correct PC RS-232 port number to connect the PAC. 
 

5. The last way is re-start your PC and try again.   

 

Stop the process which is 

with empty memory.  

https://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq104.pdf
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Appendix K Enable the Screen Saver of WinPAC 

To enable the screen saver of WP-8x47, follow these steps. 

 

1. Click [Start] > [Settings] > [Control Panel] and then double-click the Power icon. 

2. On the Schemes page, set “Power Scheme” as AC power and set both “…User Ide” and “…System 

Ide” as the same value (or set the “System Idle” value larger than the “User Idle” value). 

3. Run WinPAC Utility, click [File] > [Save and Reboot] to save the settings and restart the PAC. 

 

After the WP-8x47 is inactive for the specified amount of time, the backlight will be turned off and the 

screen saver becomes activated. The backlight will be turned on when the screen or the push-button is 

touched. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To disable the screen saver, set both “User Idle” and “System Idle” to “Never” and then remember to 

run WinPAC Utility > File > Save and Reboot. 

 

 

 

 

 

 

3. 

 

1. 

 

2. 

 

4. 
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Appendix L How to Detect the Status of Dual Battery and the 

Ethernet Port 

Notice: Power off the PAC before replacing the battery; it may cause permanent damage if the battery 

accidently touches other metal electronic parts.  
 

The WP-8x47 equips a 512 KB SRAM with dual battery design to retain the data even in the case of total 

power loss. This dual battery design allows for the replacement of one of the batteries without losing 

power and thus not losing the data stored in the memory. Warning: Do not take out two batteries at the 

same time or the data will be lost during this period of non-power.  

 

Name Type Attrib. ADR Description 

batery1 Integer Internal 9992 Detect the status of battery 1. 

batery2 Integer Internal 9993 Detect the status of battery 2. 

lan1 Binary Internal 9987 Detect the status of LAN1. 

lan1 Binary Internal 9986 Detect the status of LAN2. 

 

 To read the status of battery, using the “R_MB_ADR” function and set “ADR” as “9992” or “9993”.  

ADR number “9992” or “9993” indicates the status of battery number 1 or 2. 

 
 To read the status of the Ethernet port, using “R_MB_ADR” and set “ADR” as “9987” or “9986”.  

ADR number “9987” or “9986” indicates the status of LAN1 or LAN2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The return values after executing the program: 

"99": Power ok, no need to replace the battery.  

“0": Low power, need to replace the battery. 

The return values after executing the program: 

"1": ok. 

"0": broken-line. 
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